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Important Notice 

Copyright  

All intellectual property rights in this work belong to Zycus Inc. The information contained in this work 

must not be reproduced or distributed to others in any form or by any means, electronic or 

mechanical, for any purpose, without the prior permission of Zycus Inc., or used except as expressly 

authorized in writing by Zycus Inc. Copyright © 2007-19 Zycus Inc. All Rights Reserved 

 

Permitted Usage  

This document contains proprietary information which is the property of Zycus Inc. and is furnished 

for the sole purpose of the operation and the maintenance of products of Zycus Inc. No part of this 

publication is to be used for any other purpose, and is not to be reproduced, copied, adapted, 

disclosed, distributed, transmitted, stored in a retrieval system or translated into any human or 

computer language, in any form, by any means, in whole or in part, without the prior express written 

consent of Zycus Inc.  

 

Trademarks  

All company, brand, and product names are referenced for identification purposes only and may be 

trademarks or registered trademarks that are the sole property of their respective owners.  

 

Disclaimer  

This guide has been validated and reviewed for accuracy. The instructions and descriptions it contain 

are accurate for Zycus Supplier Network (ZSN). However, succeeding versions and guides are subject 

to change without notice. Zycus Inc. assumes no liability for damages incurred directly or indirectly 

from errors, omissions, or discrepancies between the software and the guide.  

 

Contact Us  

Visit us at www.zycus.com. For queries, contact customer support:  

E-mail ID: tech-support@zycus.com 

US Toll free: +1-800-409-3507 | +1-866-363-6625 

Australia Toll Free: +1-800-442-793 

International Toll free: + 800-9928-7111 

https://www.surveymonkey.com/r/2C3X2XK
http://www.zycus.com/
mailto:tech-support@zycus.com


 
 

 
  

Zycus Inc: 103 Carnegie Centre, Suite 201, Princeton, NJ 08540, Tel: +1 866-563-9219, Fax: 609 799 6047 

Zycus Supplier Network User Guide – Yellow 

Click Here to Give Feedback 

 

TABLE OF CONTENTS 

 

CHAPTER 1: INTRODUCTION ......................................................................................................... 6 

1.1 AUDIENCE ............................................................................................................................ 6 

1.2 PURPOSE.............................................................................................................................. 6 

CHAPTER 2: ZSN LOGIN PAGE ....................................................................................................... 7 

2.1 USER INTERFACE LANGUAGE SUPPORT ....................................................................................... 8 

2.2 HELP AND SUPPORT ............................................................................................................. 10 

2.2.2 Supplier Registration Guide ................................................................................................. 11 

CHAPTER 3: ZYCUS SUPPLIER NETWORK HOMEPAGE .................................................................. 14 

3.1 ACCESSING HELP DOCUMENTS ............................................................................................... 15 

3.1.1 ZSN User Manuals / User Videos / Online Help ................................................................... 15 

3.2 PENDING TASKS ................................................................................................................... 18 

3.2.2 Pending Tasks – Complete Profile ........................................................................................ 20 

3.2.3 Pending Tasks – Invoices ...................................................................................................... 21 

3.3 ZSN CARDS ........................................................................................................................ 23 

3.4 CNS NOTIFICATION FOR SUPPLIERS ......................................................................................... 25 

CHAPTER 4: MY CUSTOMERS FILTER ........................................................................................... 26 

4.1 HOW TO VIEW THE LIST OF MY CUSTOMERS AND VIEW DATA RELEVANT TO A CUSTOMER? .............. 26 

CHAPTER 5: SETTINGS ................................................................................................................ 28 

5.1 HOW TO UPDATE MY ACCOUNT INFORMATION? ....................................................................... 29 

5.1.1 How Can I Change My Password? ........................................................................................ 30 

5.2 HOW TO ENABLE EMAIL NOTIFICATIONS FOR PO, INVOICES, AND CATALOGS? .................................. 32 

5.2.1 Editing Email Notifications Settings ..................................................................................... 32 

5.2.2 Types of Status Change and Notification Received on Email ............................................... 34 

5.2.3 Taking actions on the emails ................................................................................................ 34 

5.3 HOW TO CHANGE THE INVOICE SETTINGS? ............................................................................... 44 

5.3.1 Editing Invoice Delivery Settings .......................................................................................... 44 

5.4 HOW TO EDIT THE PO SETTINGS? ........................................................................................... 47 

5.4.1 Editing Purchase Order Delivery Settings ............................................................................ 47 

CHAPTER 6: WHAT IS A SIDE PANEL? .......................................................................................... 54 

6.1 HOW TO NAVIGATE USING THE SIDE PANEL? ............................................................................. 55 

6.2 MY ACCOUNTS.................................................................................................................... 55 

6.2.2 How to Manage My Requests? ............................................................................................ 58 

6.2.3 My Companies ..................................................................................................................... 60 

6.2.4 Completed Requests ............................................................................................................ 62 

https://www.surveymonkey.com/r/2C3X2XK


 
 

 
  

Zycus Inc: 103 Carnegie Centre, Suite 201, Princeton, NJ 08540, Tel: +1 866-563-9219, Fax: 609 799 6047 

Zycus Supplier Network User Guide – Yellow 

Click Here to Give Feedback 

6.2.5 My Alerts .............................................................................................................................. 63 

6.3 MY CONTRACTS .................................................................................................................. 64 

6.4 MY REQUESTS .................................................................................................................... 67 

6.4.1 How to Raise a Request?...................................................................................................... 67 

6.4.2 How to View the Requests? ................................................................................................. 70 

6.5 MY PERFORMANCES............................................................................................................. 72 

6.5.1 How to View Score Events? ................................................................................................. 73 

6.5.2 How to View Performance Reports? .................................................................................... 89 

6.5.3 How to view SCARs .............................................................................................................. 92 

6.5.4 How to View Trend Analysis? ............................................................................................... 97 

6.5.5 How to View Development Programs? .............................................................................. 110 

6.5.6 How to View Tasks and Milestones?.................................................................................. 113 

6.5.7 How to View Reminders? ................................................................................................... 114 

6.5.8 How to View Notifications? ............................................................................................... 115 

6.6 MY EVENTS ...................................................................................................................... 116 

6.6.1 How to Enter an Event? ..................................................................................................... 117 

6.6.2 How Can I Recall My Response? ........................................................................................ 126 

6.6.3 How Can I Negotiate Pricing?............................................................................................. 128 

6.6.4 How Can I Respond to Auctions? ....................................................................................... 132 

6.6.5 How to Join Bidding? .......................................................................................................... 132 

6.6.6 How to Perform Bid Reconciliation? .................................................................................. 143 

6.6.7 From Where can I Access eForums? .................................................................................. 145 

6.7 MY INVOICES .................................................................................................................... 148 

6.7.1 How to View Invoices? ....................................................................................................... 149 

6.7.2 How to Create a PO Invoice? ............................................................................................. 167 

6.7.3 How to Create a Non PO Invoice? ...................................................................................... 173 

6.7.4 How to Create Credit Memo? ............................................................................................ 179 

6.7.5 How to create Credit Memo Against a PO ......................................................................... 180 

6.7.6 How to create Credit Memo without Reference ............................................................... 186 

6.7.7 Credit Memo handling on ZSN ........................................................................................... 190 

6.7.8 How to View Uploads in eInvoice? .................................................................................... 190 

6.7.9 How to View Payments in eInvoice? .................................................................................. 193 

6.7.10 Marking Filters as Favorites ............................................................................................. 200 

6.8 MY ORDERS ..................................................................................................................... 202 

6.8.1 How to Confirm/Reject a Purchase Order? ....................................................................... 203 

6.8.2 How to Create a Shipment Notice?.................................................................................... 208 

6.8.3 How to Create Direct Invoice against a Blanket Purchase Order? ..................................... 211 

6.8.4 Marking Filters as Favorites ............................................................................................... 213 

6.8.5 Exporting PO Details .......................................................................................................... 215 

6.9 MY CATALOGS .................................................................................................................. 217 

6.9.1 How to Upload a Catalog? ................................................................................................. 219 

6.9.2 How to Edit a Catalog? ....................................................................................................... 233 

6.9.3 Cloning a Catalog................................................................................................................ 241 

6.9.4 Catalog Versioning ............................................................................................................. 246 

https://www.surveymonkey.com/r/2C3X2XK


 
 

 
  

Zycus Inc: 103 Carnegie Centre, Suite 201, Princeton, NJ 08540, Tel: +1 866-563-9219, Fax: 609 799 6047 

Zycus Supplier Network User Guide – Yellow 

Click Here to Give Feedback 

6.9.5 How to Delete a Catalog? .................................................................................................. 247 

6.9.6 Deactivating a Catalog ....................................................................................................... 248 

6.9.7 Catalog Audit Trail .............................................................................................................. 249 

6.9.8 Catalog Upload Status ........................................................................................................ 253 

6.9.9 Marking Filters as Favorites ............................................................................................... 255 

6.10 FROM WHERE CAN I ACCESS MY REFERENCE DOCUMENTS? .................................................... 257 

6.10.1 View Customer Documents ............................................................................................. 257 

6.10.2 View Reference Links ....................................................................................................... 258 

 

https://www.surveymonkey.com/r/2C3X2XK


 
 

 
  

Zycus Inc: 103 Carnegie Centre, Suite 201, Princeton, NJ 08540, Tel: +1 866-563-9219, Fax: 609 799 6047 

Zycus Supplier Network User Guide – Yellow 

Click Here to Give Feedback 

Chapter 1: Introduction 

Zycus Supplier Network provides a one-stop solution for managing supplier master data. It helps 

interested suppliers to register themselves with the buyer and enables them to manage their profile 

from the portal itself. Once the supplier is registered on the Zycus Supplier Network, buyer can have 

an easy access to operational and potential supplier details, and can easily communicate with 

suppliers if any additional details are required.  

 

This, coupled with a structured workflow and approval process for managing suppliers in the master, 

ensures integrity of supplier master data. It also provides potential suppliers with information on how 

buyer companies conduct business with its suppliers and how a buyer company views supplier 

relationship in general.  

 

Zycus Supplier Network allows the interested suppliers to see the type of information buyers require 

to become their suppliers and allows interested suppliers an avenue to submit their company’s 

information to the buyer company. Suppliers interested in offering their products and services to the 

buyer companies can register themselves using the Zycus Supplier Network.  

If the buyer company approves of the supplier, the suppliers can view, edit, and submit their detailed 

profile to the buyer company through the Zycus Supplier Network and become a Potential Supplier. 

Furthermore, the buyer company can on-board a potential supplier and convert it into an Operational 

Supplier. 

 

1.1 Audience 

The intended audiences for this manual are the registered suppliers who want to manage their portal 

or suppliers who are interested in doing business with the buyer company. 

 

1.2 Purpose 

This manual is designed to explain the features of the Zycus Supplier Network and provide instructions 

to perform the functions. 

 

 

A Buyer Company is the company on whose supplier network you are registering to become 
a potential supplier. The supplier uses the Buyer Company’s portal to manage their profile. 
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Chapter 2: ZSN Login Page 
Here’s how the ZSN Login Page will appear: 

1. Enter the Zycus Supplier Network link in your internet browser and press Enter on your 

keyboard. The ZSN login page will load as shown below: 

 

 

Note: ZSN currently doesn’t support Microsoft Edge and hence we request you to use the below 

browser versions to access your account: 

Firefox support 41 or 41+ version 

Chrome support 41 or 41+ version 

Safari support on Mac 8 or 8+ version 

Safari support On Windows 7 0r 7+ version 

Internet Explorer support 10 or 10+ version 
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2.1 User Interface Language Support 

Currently you will be able to view the Zycus Supplier Network in the following languages: 

• български (Bulgarian) 

• 中文 (Chinese) 

• Dansk (Danish) 

• English (UK) 

• English (US) 

• Suomeksi (Finnish) 

• Français (French) 

• Deutsch (German) 

• Magyar (Hungarian) 

• Italiano (Italian) 

• 한글자모 (Korean) 

• Norsk (Norwagian) 

• Polski (Polish) 

• Русский (Russian) 

• Español (Spanish) 

• Nederlands (Dutch) 

• Português - Brasil (Portuguese -Brazilian) 

• 日本語 (Japanese) 

• ภาษาไทย (Thai) 

 (Arabic) العربية •
 

Disclaimer: User interface (UI) in multiple languages will be available only for, Zycus designed user 

interfaces and does not include any custom fields, any data export/reports, input data, user manuals, 

videos, release notes, net help, central notification system (CNS), hardcoded labels in the products 

which will be available only in English language. However, for any product releases, or upgrades if any 

to the existing product versions, will be provided in English language and Zycus shall endeavour to 

provide multiple languages for such releases, or upgrades to the existing product, in its due course of 

product revamp cycle which is estimated to be of 6-month time-period. 
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1. The language can be chosen from the login page as shown below:  
 

 

2. If you change the language from this page, ZSN will ask if you want to change the preferred 

language. This is because each user sets a language while configuring their profile on ZSN.  

 

3. Click Yes if you want to change the language or else click No.  

https://www.surveymonkey.com/r/2C3X2XK
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2.2 Help and Support 

1. For assistance on ZSN, you can use the Help and Support section on the login page. 

 

2. Click the Help and Support button to view frequently asked questions. The help section will 

collapse as shown in the image below: 

 

3. Navigate through the sections to find relevant help. 
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4. Click Help Video to view help videos for registering on ZSN. Clicking Help Videos will open a 

popup as shown in the image below: 

 

2.2.2 Supplier Registration Guide 
 

Supplier Registration Guide, available on the ZSN login page, will now be accessible in the above-

mentioned languages.  

To access this guide into the language of your choice: 

1. Select the locale from the login page as shown below: 

 

https://www.surveymonkey.com/r/2C3X2XK
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2. Go to Help and Support.  

 

3. Navigate to the section of Supplier Registration and click the option Supplier Registration Tour 

Guide and Help Links. 
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4. A popup will appear as shown below: 

 

5. Click the link to download the guides. 
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Chapter 3: Zycus Supplier Network Homepage 

When you login to the ZSN portal, you will be able to view Pending Tasks and Cards added on the 

homepage based on products to which you have access. 
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3.1 Accessing Help Documents 

 

To help suppliers with on-boarding and conducting other activities on ZSN, ZSN will provide Supplier 

Registration Guide and ZSN User Manual in the following languages: 

1. English 
2. Chinese (Simplified) 
3. German 
4. Japanese 
5. Portuguese (Brazil) 
6. Spanish 
7. Dutch 
8. Russian 
9. French 
 

3.1.1 ZSN User Manuals / User Videos / Online Help 
 

3.1.1.1 ZSN User Manuals 

To access ZSN help manuals in the following 9 languages: 

• English 

• Chinese (Simplified) 

• German 

• Japanese 

• Portuguese (Brazil) 

• Spanish 

• Dutch 

• Russian 

• French 

1. Change the locale of your account (by clicking on your user name from ZSN header> Settings > 

Account Settings > User Preferences > Language) to required language. 

2. Based on the language you select; the help documents will become available in that language. 

Navigate to Help section to find the relevant help document or video.  

https://www.surveymonkey.com/r/2C3X2XK
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Note: Above screenshot is an example for French (France) locale. 

3.1.1.2 ZSN Videos 

1. To access ZSN videos, go to Help > Self Training Material > Help Videos as shown in the image 

below: 

 

2. On the Help Videos page, all the videos are categorized according to the ZSN’s interaction with 

the Zycus suite of products. The category list is highlighted in the image below: 

https://www.surveymonkey.com/r/2C3X2XK
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3.1.1.3 ZSN Online Help 

1. To access ZSN online help, go to Help > Self Training Material > Online Help as shown in the 

image below: 

 

2. You will land on the following page. This page is a web version of the ZSN manual which will 

allow you to search for your queries about ZSN. 

 

3.2 Pending Tasks 

1. The top row (highlighted) is the Pending Tasks section. 

2. This section will list all the pending tasks which require you to take actions on them. 

 

https://www.surveymonkey.com/r/2C3X2XK
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Note: You can view the pending tasks either By Task name or By Customer as highlighted in the 

image below: 

https://www.surveymonkey.com/r/2C3X2XK
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3.2.2 Pending Tasks – Complete Profile 
 

1. For example, to create and fill your company profile, click Complete Profile.  

 

2. You will be navigated to the following page: 

https://www.surveymonkey.com/r/2C3X2XK
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3. Fill in the information for your company and click Create. 

 

3.2.3 Pending Tasks – Invoices 
 

1. For invoices, you will view invoices with status such as Pending Submission or Returned. 

2. For Invoice with status as Pending Submission, click View Invoice.  
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3. You will be navigated to the Update Invoice page: 

 

4. Fill in the invoice details and submit the invoice. 
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3.3 ZSN Cards 

1. Click on the icon to view the card library. 
 

 

 

2. Select the cards from the list which you want to view on your homepage. 

NOTE: The cards visible will depend upon the admin settings.  

 

3. Once you select the cards, they will appear on your home page. You can resize, and arrange the 

cards on the homepage as per your convenience. 

4. You can shuffle the cards on the homepage by dragging and dropping. You will get a message of 

Drag Your Card Here when you move the cards. 

https://www.surveymonkey.com/r/2C3X2XK
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5. You can resize the cards from the card’s border and corner using the  and arrow. 

6. You can also discard the cards by using the  button. Click Discard, the card will disappear from 

the screen. 

7. The cards will display few records on the screen. To view all the records, click on View More link 

available on the bottom right of a card. 
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3.4 CNS Notification for Suppliers 

There will be an in-app notification to alert suppliers about product related developments by Zycus. 

All the new notifications will come on the top, the notification trey will be open if there are any new 

notifications, if the user clicks on Hide all, the notifications will be hidden, even if the user is directed 

to the home page from some other page. 

If there is any new notification, when the session is active then only the notification trey will open, 

and the unread count will increase. The count will be decreased if the user clicks on a notification, 

and the notification will be marked as a read notification.  

 

 

https://www.surveymonkey.com/r/2C3X2XK


 
 

 
  

Zycus Inc: 103 Carnegie Centre, Suite 201, Princeton, NJ 08540, Tel: +1 866-563-9219, Fax: 609 799 6047 

Zycus Supplier Network User Guide – Yellow 

Click Here to Give Feedback 

Chapter 4: My Customers Filter 

Zycus Supplier Network portal provides you the My Customers filter to provide a quick filter to 

display Customer Data. All Customers mapped to your account are displayed in the Drop-Down list. 

 

4.1 How to View the List of My Customers and View Data Relevant to a 
Customer? 

 

My Customers filter is present on the Home page of the Zycus Supplier Network portal. 

Click on Manage Companies on the dashboard and select My Customers. 

 

 

 

1. Click on the drop-down box of My Companies or My Customers 

2. Select the required Company or Customer 

3. Click Go. All the companies relevant to you are displayed. 

4. You can edit a company’s information by clicking the  from the Actions column. Select a 

business unit you want to edit. 

https://www.surveymonkey.com/r/2C3X2XK
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5. For next steps, refer How to Edit a Supplier Company? 
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Chapter 5: Settings 

Zycus Supplier Network provides users the flexibility to manage their profile, set their preferences, 

change password along with managing settings for Invoices and Purchase Orders. 

The Settings menu can be accessed by clicking on the Display Name of the User present on the top 

right corner as shown below: 

 

 

Clicking Settings will provide the user access to the following ZSN Settings: 

 

Name 
 

Description 
 

Account Settings Allows you to update your User Details & Preferences 

Email Notification 
Settings 

Allows you to enable email notifications to receive updates on 
Catalog, PO, and Invoices 

Invoice Settings Provides access to settings related to Invoice Delivery 

PO Settings Provides access to settings related to Purchase Order Delivery 
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5.1 How to Update My Account Information? 

To edit User Details and Preferences: 
 

1. Navigate to the following location: Your Display Name > Settings > Account Settings. 
 

 

2. Click the    icon corresponding to the required section: User Details or User Preferences. 
 

3. Under the User Details section, you can modify the following details: 

• First Name 

• Last Name 

• Display Name 

• Job Title 

• Email Address 

• Phone 

• Fax 
 
4. Under the User Preferences section, you can modify the following details: 

• Time Zone 

• Number Format 

• Date Format 

• Time Format 

• Currency 

• Language  
 

5. Click Save corresponding to the section in which the changes are made. 
 

https://www.surveymonkey.com/r/2C3X2XK
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5.1.1 How Can I Change My Password? 
 

To edit User Details and Preferences: 
 

1. Navigate to the following location: Display Name > Settings > Account Settings. 
 

 

 

2. Click on the Change Your Password link. 

 

3. Enter the Current Password along with the New Password. 
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4. Reenter the New Password in the Confirm Password text box. 

 

5. Click Change Password to complete the password change procedure. 
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5.2 How to enable email notifications for PO, Invoices, and Catalogs? 

The Email Notification Settings allow you to configure setting so that you will receive notifications 

about PO, Invoice, and Catalogs. 

5.2.1 Editing Email Notifications Settings 
 

1. Click on the Display Name as highlighted in the image below:  

 

 

2. A menu will collapse. From the menu, click Settings. 

 

 

3. Settings section will expand and show the following options: 

• Account Settings 

• Email Notifications Settings 

• Invoice Settings 

• PO settings 
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4. Click Email Notifications Settings. 

 

 

5. You will be navigated to the following page: 

 

6. Enable settings as per your requirements. If you want to receive notifications for Catalog, 

Invoices and POs, check the boxes against each entities. 

7. Click Save once you finish enabling the notifications settings. 
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5.2.2 Types of Status Change and Notification Received on Email 

You will receive status notification for all below status changes and notifications on email: 

• New PO Received 

• PO confirmed 

• PO rejected 

• New Invoice Creation 

• Invoice Submitted 

• Invoice in approval 

• Invoice Rejected 

• New Catalog Submitted 

• Catalog Approved 

• Catalog Rejected 

• Catalog Published 

Note: You will be able to take action from these emails without logging in to ZSN; however you will be 

restricted to go to any other page on ZSN. 

5.2.3 Taking actions on the emails 
1. Once the email notifications have been enabled, you will start receiving notifications on the 

registered email address. 

2. For example, while receiving a new purchase order, you will be notified via email as shown 

below: 

If the user has access to Zycus eInvoice, the email will have a single button to Confirm and Create PO 

apart from Confirm, Reject, and View PO as shown below: 

 

Note: Purchase Orders created for suppliers that are not registered on ZSN, will NOT be auto-

confirmed by the system. Clicking Confirm, Reject, Confirm, or Create Receipt will take the supplier 
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to the registration page on ZSN. Supplier will have to register on ZSN to take action on the PO. Post 

registration, they can take an action from the e-mail itself, or from the Supplier Network. 

If the user doesn’t have access to Zycus eInvoice, the email will only have Confirm button as shown 

below: 

 

NOTE: The emails received will contain the details of the PO. The PDF attachment of the PO may or 

may not be present in the email depending on the settings selected by the buyer organisation.  

3. The emails will have actionable buttons. You can choose to Confirm, Reject, Confirm PO, and 

Create Invoice or View PO from the email.  

4. If you are a registered user, you can perform these actions without logging in to the ZSN tool. 

However, you won’t be able to navigate anywhere else in the tool. 
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5.2.3.1 View PO 

 

Click View PO, you will be redirected to the PO on ZSN as shown below:

 

1. The status of the PO will be unconfirmed (highlighted in the image above). 

2. You can take actions (Download as PDF, Preview PO cXML, Confirm, Reject) on this PO by 

clicking the actions menu. 
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5.2.3.2 Confirm PO 

 

1. Click Confirm, you will be redirected to the Confirm PO popup on ZSN as shown below: 
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2. Enter the Estimated Delivery Date and Comments before clicking Confirm PO. 

3. You will be able to confirm the PO without logging on ZSN.  

4. Once confirmed, you will get a notification about PO confirmation as shown below. 

 

NOTE: To take more actions, click Login. 

5. If you confirm a PO which is already confirmed, then you will get the following popup: 

 

Note: On clicking Login, you will be redirected to the following page: 

 

6. The confirmation of PO will also be sent as a mail notification to the supplier. 
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7. The confirmation email will have actionable buttons to Create Invoice, Create Shipment Invoice 

and View PO. 

 

5.2.3.3 Create Invoice 

 

1. Click Create Invoice from the email, you will be navigated to the following page: 
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Note: You will be able to create an invoice without logging on ZSN. 

Note: In case you don’t submit the invoice, then it will not be saved as a draft.  

2. A side by side panel will open from where you can create an invoice to a confirmed PO. 

3. You will be able to add attachments for this invoice only from your computer. You won’t be able 

to attach documents from the Uploads section. 

4. Once you submit the invoice, you will get the following popup: “You have now successfully 

submitted the invoice against the Purchase order. You can now login to perform more 

actions.” 

5. You will receive status updates on your submitted invoice via emails. For example, you will be 

notified on successful creation of Invoice as shown below: 

 

Note: In case if you try to create Invoice against a PO which is already invoiced, then you will get 

following message: “The PO has been already fully invoiced by another user from your 

organisation. You can now login to perform other actions”. 

Note: In case if you don’t have the necessary rights to create invoice then you will be redirected to 

the Access denied page.  

 

5.2.3.4 Confirm PO and Create Invoice 

 

Suppliers will be able to Confirm Purchase Order and Create Invoice directly from the “Purchase 

Order Received” e-mail notification. 

The e-mail notification will have a single button “Confirm and Create Invoice”. When the supplier 

clicks the button, the Purchase Order will get confirmed and he will get redirected to the invoice 

creation page. 

Refer section Create Invoice for reference. 
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5.2.3.5 Create Shipment Invoice 

 

Once your PO is confirmed, you will receive an email confirmation. From that email, you will have an 

option of creating a shipment invoice against that PO. 

 

1. From the email body, click Create Shipment Invoice. 
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2. You will be navigated to the New Shipping Notice page: 

 

 

3. Fill in the shipping details and click Submit. 

 

4. You won’t be able to navigate anywhere else in the tool. After clicking Submit, you will see the 

following message popup: “You have now successfully submitted the shipment notice against 

the Purchase order. You can now login to perform more actions.”  

 

5. You can choose to login to ZSN or close the application. 

 

6. If the Shipment Notice is already created, then you will see the following message: “Shipment 

notice is already created against this PO by another user from your organisation. You can now 

login to perform other actions.” 

7. If you don’t have sufficient rights to create a Shipment Notice, then you will be shown the 

Access Denied page. 
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5.2.3.6 Reject PO 

1. Click Reject, you will be redirected to the Reject PO popup on ZSN as shown below: 

 

2. Enter the Comments before clicking Reject PO. 

 

5.2.3.7 Viewing Catalog 

1. If you have created and submitted a catalog on the ZSN portal, then you will be notified about 

your submission via email. 
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Note: You will be notified about every change in the catalog status via email. 

 

5.2.3.8 Multi-Lingual Support for Emails 

 

If the customer has configured email templates in various languages, supplier contacts will receive 

such actionable emails based on the preferred language set in their ZSN account. 

 

5.3 How to Change the Invoice Settings? 

The Invoice Settings page allows you to modify the Invoice Delivery Settings like Customer & 

Supplier Company along with Supplier, Sender & Buyer Credentials. 

 

5.3.1 Editing Invoice Delivery Settings 
 

To edit Invoice Delivery Settings: 
 

1. Navigate to the following location: “Your Display Name” > Settings > Invoice Settings 
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2. Select the required Customer and Supplier Company. 
 

3. Select the required Invoice Delivery option under the Delivery Method drop-down.  
 

4. Perform the required steps based on the Delivery Method selected: 
 

A. cXML: 

 

i. Select the cXML Version 
ii. Enter the required information in the Supplier (From) Credentials, Sender 

Credentials and Buyer (To) Credentials. 
iii. You can configure an email for sending cXML delivery failure messages under 

Send cXML delivery failures via email to, so the correct user will be notified in 
case of failures. 
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B. EDI (Electronic Data Interchange): 

 

i. Select the method used for transmitting EDI messages under the Type 

drop-down. 

Note: Zycus currently supports EDI via VAN (Value Added Network) 

ii. Select the EDI Address Qualifier from the drop-down list available. 

Note: EDI Address Qualifier is a 2-character code which represents the type of EDI Address. Zycus currently 
supports the ANSI ASC X12 EDI Standard, version 4010 

iii. Enter the EDI Address for sending the Invoice. 

Note: The EDI option is a Value Added Service and suppliers can only select it if their customer has enabled it. 
Otherwise it will be Disabled (greyed out). 

iv. You can configure an email for sending EDI Invoice failure messages under 

the Send EDI Invoice failure notifications via email to option, so the 

correct user will be notified in case of failures. 

 

5. Click Submit to save the changes made to the Invoice Delivery Settings 
 

 

 
Access to Invoice Settings is only allowed when the access to eInvoice has been enabled. 
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5.4 How to Edit the PO Settings? 

The PO Settings page allows you to modify the PO Delivery Settings like Customer, Supplier 

Company & Delivery method along with Supplier, Sender & Buyer Credentials. 

 

5.4.1 Editing Purchase Order Delivery Settings 
 

To edit Purchase Order Delivery Settings: 
 

1. Navigate to the following location: “Your Display Name” > Settings > PO Settings 
 

 

 

2. Select the required Customer and Supplier Company. 
 

3. Select the required PO Delivery option under the Delivery Method option. 
4. Perform the required steps based on the Delivery Method selected from the drop-down: 
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A. Online: POs will be visible upon logging into the network. This will be the default PO 
delivery method for new suppliers. 

i. Choose if you want to Automatically confirm the PO's received from this 
customer. The default setting will be No. 

ii. Enabling this setting will automatically confirm all PO's sent by your customer. 
 
B. Actionable Email: PO will be received as a PDF attachment via e-mail. Actions such as 

Confirm PO, Reject PO or Create Invoice can be taken from the e-mail itself. This 
option should be enabled only if tenant level setting for allowing PO actionable e-mails 
is enabled. 

 
C. Email: 

i. Enter the recipients for the email for the Purchase Order Delivery. 
ii. In case of multiple recipients, use comma to separate email IDs. 
iii. Choose if you want to Automatically confirm the PO's received from this 

customer. The default setting will be No. 
iv. Enabling this setting will automatically confirm all PO's sent by your customer. 
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D. cXML: 

 

i. Select the cXML Version. 
ii. Enter the Order Submission URL. 
iii. Choose whether you want to Receive cXML notifications for PO cancel, close, 

and amend details. 
iv. If you want to Allow ZSN to re-send failed Purchase Orders, select Yes or else 

select No. A few key points to be noted about this are: 

• This feature is for the integration suppliers that receive Purchase 

Orders via cXML.  

• In case the Zycus Supplier Network does not receive a success 

message from the supplier’s ERP system, the supplier can authorize 

ZSN to re-send the PO. 

• When set to Yes, ZSN will resend the PO up to 3 times in intervals of 

15 minutes each. 

• If the PO has failed after these attempts as well, an email 

notification will be sent to the supplier contact configured to receive 
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these failure emails. The email will contain a consolidated list of 

PO’s that have failed over the past few hours. 

• The cXML response received from the supplier system will be shown 

against each PO, with an option to resend the PO. The reason for 

failure can be seen upon opening the PO as shown in the following 

screenshot: 

 

• A yellow warning icon,  will be shown against such invoices on 

the PO listing page. 

v. Enter the required information in the Supplier (To) Credentials, Sender 
Credentials and Buyer (From) Credentials. 

vi. You can configure an email for cXML delivery failures messages, so the 
correct user will be notified in case of failures. 

 
Note: Re-Triggering Of cXML From The Failure Email Notification 
If ZSN fails to send the PO via cXML to a supplier, an email notification will be sent to the supplier 

based on email notification setting in ZSN which will have the Retrigger button as shown in the 

image below:  
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This setting in ZSN allows the supplier to input the email IDs who will be notified in case of any cXML 

failure via email. If the retrigger action is taken from any one of the email id's, ZSN will perform the 

PO cXML retrigger. 

Once the cXML status is successful, the supplier will not be able to retrigger it again. If a Re-Trigger 

action is taken, it will be locked for 3 Minutes or till the time ZSN do not receive the status of cXML 

(whichever is less in time interval). This will avoid any chance of duplication if any other supplier 

contact tries to click the retrigger button. 

E. EDI (Electronic Data Interchange): 
When the EDI option is selected, the customers EDI qualifier and address will be 
displayed. (This will help the supplier set-up his VAN and not reach out to 
customer/Zycus separately for customer EDI details). 

 

i. Select the method used for transmitting EDI messages under the Type drop-
down. 
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Note: Zycus currently supports EDI via VAN (Value Added Network) 
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ii. Select the EDI Address Qualifier from the drop-down list available. 

Note: EDI Address Qualifier is a 2-character code which represents the type of EDI Address. Zycus currently 
supports the ANSI ASC X12 EDI Standard, version 4010 

iii. Enter the EDI Address for sending the PO. 

Note: The EDI option is a Value Added Service and suppliers can only select it if their customer has enabled it. 
Otherwise it will be Disabled (greyed out). 

 
5. Click Submit to save the changes made to the Purchase Order Delivery Settings. 

 
Access to PO Settings is only allowed when the access to eProc has been enabled. 

 
EDI Enabled Suppliers will get email notification in case of PO amend. 
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Chapter 6: What is a Side Panel? 

The Side Panel on the ZSN Portal allows convenient access to options available to you. The Side 

Panel can be accessed by clicking the  icon present on the top left of the screen. 

 

The Side Panel provide access to the following option: 

1. My Accounts – Allows access to Companies, Requests & Alerts from the Supplier Management 

portal 

2. My Invoices – Allows access to view invoice created by your Customers & to create PO & Non PO 

Invoices 

3. My Orders – Allows access to Purchase Orders linked to the eProcurement portal of Zycus 

4. My Catalogs – Allows access to Catalogs linked to the eProcurement portal of Zycus 

5. My Payments - Allows access to Payments linked to the eInvoicing portal of Zycus 
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6.1 How to Navigate using the Side Panel? 

To navigate among various modules of Zycus Supplier Network, click on the  icon present at the 

top left. Click on the required module, the sub modules (if any) is displayed. Hover over the sub 

module and select the required Customer. 

 

6.2 My Accounts 

The My Accounts option allows the user to view Companies, Requests & Alerts from the Supplier 

Management portal of Zycus. 

 

My Accounts tab consist of views like: 

a) My Request 

b) My Companies 

c) Completed Requests 

d) My Alerts 

 

1. My Requests tab: 

 

a. Submit Requests 

b. Edit Requests 
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c. Delete Requests 

 

 

2. My Companies tab: 

 

a. Edit Company Details 

 

 

3. Completed Requests tab: 

a. View Company Details 

b. View Approval Status Updates 
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4. My Alerts tab: 

a. View Company Details 

b. Act on the Alert 
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6.2.2 How to Manage My Requests? 
 

The My Requests tab allows the user to view the supplier companies registered using ZSN. 

6.2.2.1 How to Submit a Request? 

 

To submit a Supplier Company Request: 
 

1. Navigate to the following location: Side Panel > My Accounts > Required Supplier Company 
 

2. Look for the required Supplier Company with Status as Saved as Draft 
 

3. Click on the  icon corresponding to the required supplier company. 
 

 

6.2.2.2 How to Edit a Request? 

 

To edit a Supplier Company Request: 
 

1. Navigate to the following location: Side Panel > My Accounts > Required Supplier Company 
 

2. Look for the required Supplier Company with Status as Saved as Draft 
 

3. Click on the  icon corresponding to the required supplier company. 
 

4. Make the required changes in the Supplier Company Request. 
 

5. Perform any one of the following actions as required: 
 

A. Save as Draft: To save the changes made in the draft Supplier Company Request. 
B. Save & Submit: To save the changes made in the draft Supplier Company Request and 

submit the request for approval. 
C. Cancel: To discard the changes made in the draft Supplier Company Request and exit. 

 

Submitting a Supplier Registration request with incomplete/missing details, will display an 
error message similar to the one shown below: 
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If Cancel is clicked, the following dialog box is displayed: 

 

 

 

Click Yes to discard changes made and exit. Click No to keep the changes made and return to editing. 

 

 

6.2.2.3 How to Delete a Request? 

 

To delete a Supplier Company Request: 
 

1. Navigate to the following location: Side Panel > My Accounts > Required Supplier Company 
 

2. Look for the required Supplier Company with Status as Saved as Draft 
 

3. Click on the  icon corresponding to the required supplier company. 
 

 

 

4. Click Yes to delete the Supplier Company Request. 
 

 

 
Only Supplier Company Registration requests with status Saved as Draft can be edited. 

 
Only Supplier Company Registration requests with status Saved as Draft can be deleted. 
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6.2.3 My Companies 
 

The My Companies tab allows the user to view the current on-boarded supplier companies.  

  

6.2.3.1 How to Edit a Supplier Company? 

 

To edit a Supplier Company: 
 

1. Navigate to the following location: Side Panel > My Accounts > Required Supplier Company 
 

2. Navigate to the My Companies and look for the required Supplier Company 
 

 

 

3. Click Edit from the Actions column corresponding to the required supplier company. 
 

Note: The Edit or View hyperlinks will be deactivated if you don’t have sufficient rights. 

 

4. Select a business unit to edit. 
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5. Make the required changes in the Supplier Company. 
 

6. Perform any one of the following actions as required: 
 

A. Save as Draft: To save the changes made in the draft Supplier Company Request. 
B. Save & Submit: To save the changes made in the draft Supplier Company Request and 

submit the request for approval. 
C. Cancel: To discard the changes made in the draft Supplier Company Request and exit. 

If Cancel is clicked, the following dialog box is displayed: 

 

 

 

Click Yes to discard changes made and exit. Click No to keep the changes made and return to editing. 

 

 

 
Only Supplier Company Registration requests under the Users scope can be edited. 
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6.2.4 Completed Requests 
 

The Completed Requests tab allows the user to view the supplier company requests that have 

passed through the Approval Workflow.  

 

 

 

Clicking on the Status of the supplier company request, displays the details of the Approval 

Workflow of the Supplier Company Request. 
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6.2.5 My Alerts 
 

The My Alerts tab allows the user to view the alerts for which some action needs to be taken by the 

User. Once the required action is acted on by the User, the status of the Alert can be changed.  

 

 

6.2.5.1 How to Act on an Alert? 

 

To act on an Alert: 
 

1. Navigate to the following location: Side Panel > My Accounts > Required Supplier Company 
 

2. Navigate to the My Companies and look for the required alert 
 

3. Click on the  icon corresponding to the required alert. 
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4. Select the Status of the alert as per requirement. 
 

 

5. Enter the required Comments in the text box. 
 

6. Perform any one of the following actions as required: 
A. Submit: To save the changes made in the alert and exit. 
B. Cancel: To discard the changes made in the alert and exit. 

 

6.3 My Contracts 

 

NOTE: The above-mentioned menu may or may not be available based on the access provided to you by 
customer. 

 

The My Contracts option allows the user to view all the contracts linked to the customer company. 

1. Click on My Contracts. You will get an option of View Contracts. 

2. Hover over View Contracts, you will be able to see list of customer company whose contracts 

you want to see. 

 

 

3. Select the customer of your choice; you will be navigated to the following page. 

 
 
4. You can search for contracts awaiting review by Contract Number or Contract Title. 

 Click on the  icon to view details about each Status. 
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5. Against any contract number, click on the Actions drop-down menu. You will get following options: 

 
 

6. You can view or modify contract. You will be navigated to authoring contract page in a new window. 

 
 
7. You can edit the contract. A download popup will be displayed. You can save it on your local system. 

 
 
8. You will also be able to download a contract. You will get following popup: 
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You can click proceed or check-out. 
 
9. You can also undo all the modifications made to the current contract. You will get following popup: 

 
Select yes or no as per your requirement. 
 
10. You will also be able to mark the contract as reviewed. Click Mark as Reviewed, you will get following 

comment box. 

 
 
11. Enter your comments as per your review and click Submit. The contract owner will be notified 

through an email. 
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6.4 My Requests 

NOTE: The above-mentioned menu may or may not be available based on the access provided to you by 
customer. 

 
In scenarios when the supplier wants to request a few changes with respect to pricing, delivery terms, 
and delivery locations and so on, he can raise such request from this section. 
 
My Requests option allows the user to: 
1. Raise a new request  
2. View the status of requests 
 

 

6.4.1 How to Raise a Request? 
 

To raise a request, go to: 

1. Side Panel > My Request > Create New Request > select the buyer company. 

 

2. You will land on the following page: 
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3. Click +New Request. You will see the following popup and you will need to select a request 

definition and click OK. 

4. The request definitions you see in this popup will be configured by your buyer. 

 

5. On select the request definition, you will land on the following page: 
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Section One: 

1. In this section, you will need to add at least the basic details such as Request Name and 

Supplier. 

2. In addition, you can also add your Request Description, Attachments (any supporting 

documents), and mark the request as Urgent Requirement. 

3. Once these details are filled, select to whom in the buyer organization you want to assign this 

request. You can select a single buyer or a buyer group. 

 

Section Two: 

4. The fields in this section are custom and configured by your buyer. This section will vary from 

buyer to buyer.  

5. Once the details for this section are filled, you can choose to review the workflow this request 

will follow. Click Preview Workflow, which is available in the footer of the page. You will see the 

following popup: 

 

6. Once all the information is in place, you can either Submit the request or Save it as Draft.  

7. Saving it as draft will allow you to work on it later. Once you hit Submit, the workflow will be 

triggered, and you won’t be able to make any changes. 

8. Such requests will be visible on the My Request > View Requests page as shown below: 
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6.4.2 How to View the Requests? 
 

1. To view the request you have raised, go to: Side panel > My Requests > View Requests > select 

the buyer company. You will land on the following page: 

 

2. On this page, you will see the requests by all the users raised from your organization. 

3. For the requests which are in Draft status will be editable. 

4. To view a request, click the Request Number. You will land on the following page: 
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Note: All the sections and their field (except Workflow and Audit Trail) will vary depending on your 

buyer company. 

5. The workflow section will show the status of your request. 

 

6. The audit trail will display all the changes made to the request from the time it was submitted. 

 

 

  

https://www.surveymonkey.com/r/2C3X2XK


 
 

 
  

Zycus Inc: 103 Carnegie Centre, Suite 201, Princeton, NJ 08540, Tel: +1 866-563-9219, Fax: 609 799 6047 

Zycus Supplier Network User Guide – Yellow 

Click Here to Give Feedback 

6.5 My Performances 

NOTE: The above-mentioned menu may or may not be available based on the access provided to you by 
customer. 

 

The My Performances option allows the user to view: 

1. Score Events 

2. Performance Reports 

3. Development Programs 

4. Tasks and Milestones 

5. Reminders 

6. Notifications  

for each customer. 
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6.5.1 How to View Score Events? 
 

Under My Performance, hover over View Score Events. A list of Customer Company will be 

provided. Select the customer company of your choice for whom you want to score the event.  

Once you have reached the scoring events page, follow the steps mentioned below to the score the 

event online through the system itself. 

6.5.1.1 Scoring Events Online 

To score an event online: 

 

1. Once you click on the link from the email, the Score Events page is displayed: 
 

 

 

 
2. Search for the required event using the Event Name and/or the Event Owner search box. 
 

 

 

3. Click on the Respond button in the Actions column for the corresponding event to open the 
survey. 
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4. The survey page is displayed with the Survey Scope tab open. 
 

 

 

5. Select the Scoring Layout from the given options:  
 

 

 

 

Layout Description 

 

Select the Suppliers to Facilities layout to score a supplier linked to multiple 
facilities. 
 

 

Select the Facilities to Suppliers layout to score multiple suppliers linked to 
a single facility. 
 

 

6. Click on the Save and Continue button to continue with the survey. The Survey Form is displayed. 
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7. Expand the required facility or supplier using the  icon to view the list of KPI’s.  
 

8. Select the required KPI from the list of KPI’s displayed. The list of questions associated with the 
KPI will be displayed.  

 

9. Provide answers for all the questions. 
 

10. Perform any of the following actions for any of the question as required: 
 

a. Comment: 
 

i. Provide a comment for a question in the survey 
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b. Attachment: 
 

i. To attach a document for a question in the survey, click on the  icon next to the question. 
 

ii. A dialog box is displayed with the Attachments tab open. 
 

 

 

iii. Click on the Upload Files button to upload the document. 
 

iv. The File Upload dialog box is displayed. Browse and select the required file. 
 

v. Click on the Open button to upload the document. 
 

vi. The uploaded file will be displayed in the table along with its size. 
 

vii. To complete the process, click on the Done button. 
 

c. Copy Response: 
 

i. To copy response for a question in the survey form to a survey form for another 

facility/supplier, click on the  icon next to the question. 
 

ii. A dialog box is displayed with the Copy Response tab open. 
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iii. Click on the Copy Responses button to copy the response for the question to a survey for 
another facility/supplier. 

 

iv. The Information dialog box is displayed. Click on the OK button to continue. 
 

v. To complete the process, click on the Done button. 
 

11. To navigate in between KPI’s use the Previous KPI and Next KPI links on the bottom right. 
 

12. Provides all answers to all applicable KPI’s for suppliers/facilities selected. 
 

13. Click on the Save and Continue to save the entered responses and move to the next step. 
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14. The Summary tab is displayed which displays completion status of the survey at Supplier, Facility 
& KPI level. 

 

 

 

To filter the summary, use the Filter By dropdown box located on the top right of the Summary tab. 

 

 

 

Note: Click on the number of Total Unanswered Questions/Mandatory Unanswered Questions to 

directly go to the unanswered question/mandatory unanswered question under the survey form tab. 

 

15. Click Submit Response to submit the responses. The following message is displayed. 
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16. Click Continue. The scores are submitted, and the Score Events page is displayed. 
 

At any point in the survey, you can click on "Exit" button to exit the survey with following three 

options:  

 

• Yes: Click on this option to save the entered data and then Exit the survey. 
 

• No: Click on this option to not to save the entered data and Exit the survey. 
 

• Don't Exit: This option will keep you on the same page. 
 

To filter the KPI’s in the Suppliers/Facilities module, click on the  icon, select the required 

option and click on the Filter link. 

 

 

 

To filter questions according to their statuses, use the Question Status dropdown box on the top 

right side of the page under the Survey From tab. 

 

 

 

To know the completion status of the survey, use the Mandatory Completion Status dropdown box 

on the top right side of the page next to the progress bar. 
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6.5.1.2 Scoring Events Offline 

To score an event offline: 

 

Follow the steps mentioned below to the score the event offline by downloading the event template 

in excel format, scoring it offline and uploading it back into the system. 

 

1. Once you click on the link from the email, the Score Events page is displayed: 
 

 

 

2. Search for the required event using the Event Name and/or the Event Owner search box. 
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3. Click on the Respond button in the Actions column for the corresponding event to open the 
survey. 

 

4. The survey page is displayed with the Survey Scope tab open. 
 

 

 

5. Select any one of the following scoring layout as required: 
 

Layout Description 

 

Select the Suppliers to Facilities layout to score a supplier linked to multiple 
facilities. 
 

 

Select the Facilities to Suppliers layout to score multiple suppliers linked to 
a single facility. 
 

 

6. Click on the Export button and select the type of survey form to be exported. The survey form 
contains the questionnaire template in an excel format. The exported template will contain 
prepopulated names of supplier, facilities, KPIs and the questions to be scored of the selected 
suppliers and facilities. 
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Note: In case there are more than 200 suppliers in an Event, users can score suppliers only through 

offline scoring. 

 

Note: A Custom Survey From is a transpose of a Standard Survey Form i.e. suppliers/facilities names 

are displayed in rows custom. 

 

Note: If a Custom Survey From is exported, fields need to be mapped manually when the custom 

survey form is uploaded into the system. 

 

Export 

Type 
Description 

Standard 

Survey 

Form 

In the Standard Survey Form, the questions are displayed in the rows and the 

Suppliers/Facilities names are displayed in the columns. 

 

 

 

Custom 

Survey 

Form 

In the Custom Survey Form, the Suppliers/Facilities names are displayed in the rows and 

the questions are displayed in the columns. 

 

 

 

 

7. User can fill the responses for each question in the corresponding column, for each supplier-
facility combination, as shown in the above image. 
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Note: The exported template is user specific, i.e. the template would contain only those KPI’s to 

which the user is invited. 

 

Note: The “Responses” worksheet is password protected. 

 

Note: The “Instructions” worksheet contains guidelines to help the user to fill the template. This 

worksheet also contains the password to access “Responses” worksheet. 

 

Note: User can add or delete a row/s from the worksheet by unprotecting it using the password 

specified in the Instructions sheet. 

 

Note: Data validation rules as well as comments are incorporated in the fields wherever required. 

 

8. Once you have filled in the responses into the exported template, click on the Import button and 
select Import Responses to import this template back into the system. The Upload Scores dialog 
box is displayed. 

 

 

 

9. Select the KPIs for which scores are to be uploaded and then click Upload File. 
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10. The File Upload dialog box is displayed. Browse and select the required file. 
 

11. Once the file is uploaded, click on the Next button to continue. 
 

12. The Upload Scores dialog box is displayed. 
 

Note: The size limit set for scoring file to be uploaded for auto scoring is 25 mb. 

 

 
 

13. In this dialog box, the fields will get mapped automatically in the corresponding fields only if the 
uploaded file is the template exported from the application as mentioned in Step 10. 

 

Note: The user can also upload score using any other customized template, but in that case the user 

has to manually map the fields in the template with the fields shown online. 

 

Note: If no questions are mapped to any of the selected KPI then the following error message is 

displayed. 

“You need to map atleast one question to each of the selected KPI" 

 

14. Click on the Import Scores button once all fields are mapped. 
 

15. After successfully mapping all the fields, the Scores imported successfully dialog box is 
displayed. Click on the Done button to continue. 
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16. Click on the Import tab and select the View uploaded files link to view attachments, if any, 
uploaded for your reference. 

 

17. To submit the uploaded responses, click on the Summary tab. Click on the Submit Responses to 
submit the uploaded responses. The following message is displayed: 

 

 

 

18. Click on the Continue button to submit the responses. 
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6.5.1.3 View Uploaded Files 

To view the uploaded files: 

 

1. On the Score Events page, search and open the required survey. 
 

2. Click on the Import button and select the View uploaded files option to view the uploaded 
survey forms.  

 

 

 

3. The View uploaded files dialog box is displayed. 
 

 

 

6.5.1.4 Modify Responses 

Once you have submitted your responses for an event, you will have the option to modify your 

responses for that event until that event gets closed.  

 

To modify responses: 

 

On the Score Events page, for an event having Status as In Progress and Submission Status as 

Submitted, you will get the option  
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1. Click  to edit and resubmit the responses for a corresponding event. The 
following message is displayed. 

 

 
 

2. Click on the Continue button to continue with the modification. 
 

Note: The Event Scorers will able to make changes to their submission and re-submit in case they feel 

there were any errors in their answers or if they missed out on filling certain details. Resubmission 

can be done any number of times till the event closes. Once the submission is re-called, it should be 

submitted again before the event closes for the scores to be counted. 

 

3. Follow the standard process of filling the survey and make the required changes. To resubmit the 
modified responses, open the Summary tab and click on the Submit Responses button. 
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6.5.1.5 Delegate a Scoring Event 

A scorer has the option to delegate a scoring event to some other user in case if the scorer wants 

that user to score on behalf of him. 

 

To delegate a scoring event: 

 

On the Score Events page, for an event having Status as In Progress and Submission Status as 

Pending, you will get the option  

 

 

1. For a corresponding event, click Delegate to forward the invite to other user to 
score. The following dialog box is displayed. 
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2. Enter the email address of the person you want to score this event on behalf of you. 
 

3. Click Delegate. An email will be sent to the delegated user. 
 

Note: The score from a particular user or on a particular user’s behalf will be accepted only once. 

 
 

6.5.2 How to View Performance Reports? 
 
Under My Performance, hover over View Performance Reports. A list of Customer Company will be 

provided. Select the customer company of your choice for which you want to view the performance 

reports. Following page will be displayed: 

 

 

 

1. To compare performances for different events, select the events by checking the box against 

their name. 

2. Once you complete selecting the events, click on Compare Performance.  

 

Note: The suppliers can compare performances for up till 5 events. 

Note: This page will only show all the published events. 
 

3. Click to view the performance of the respective supplier. The Supplier Performance Report 
page is displayed. 
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4. Click Export Report to export the performance report for an event. The performance report will 

be exported to PDF. 
 

5. Click Print Report to print the performance report for a supplier or all suppliers in an event. 

 
6. Click Change to change the Event or the performance evaluation period. 

 

 

 
7. Click Report Details to view the score details of each KPI.  
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8. The report details page will open: 
 

 
 

9. Click Graphic Visualization to view an interactive data visualization tool that allows you to view 

the three dimensions - KPI, Facility and Region in a pictorial form. 
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6.5.3 How to view SCARs 
 

Under My Performance, hover over VIEW SCARS. A list of Customer Company will be provided. 

Select the customer company of your choice for which you want to view the SCAR programs. 

Following page will be displayed: 
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6.5.3.1 SCAR Listing page  

 

 

 
1. The SCAR listing page displays a list of corrective requests from the buyers to the suppliers.  

2. The suppliers must respond to the corrective requests within a designated time (as per the date 

mentioned under the tab Response Due). 
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3. Click on the SCAR which needs to be responded, the selected SCAR will display the number of stages 

present, and the status of the response for each Stage of the SCAR. 

 

4. Click on Respond under the Actions tab. 

5. The SCAR page will open on the same stage where the response is required by the supplier. 

6. The questions listed for that stage will have to filled. 

 

7. Once all the responses are given, click on Submit. The following pop-up will occur once the supplier 

hits the Submit button.  
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8. Once the responses are submitted, the supplier will not be able to edit the responses. 

9. If the SCAR responses are not filled within the designated time given by the Buyer, the Supplier will 

view the Overdue status under Response Due in the listing page. Please refer the following figure. 

 

 

10. Once the responses are submitted by the Supplier, the same responses can be Accepted or Rejected 

by the Buyer who has raised the SCAR request to the supplier. 

11. The accept/reject of each stage response will be visible to the supplier, under the Status tab for each 

SCAR in the listing page. 

12. Supplier will also be able to view all the responses with the help of the View Responses button. 
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6.5.3.2 SCAR Archives 

 

1. All the SCARs which has been assigned to the Supplier (SCARs which has been responded 

and closed) are listed in this page. 

 

2. The SCAR Number, Facility/Plant, Supplier Name, GSID, Owner, SCAR Reported On date and 

Closed On date and Actions for each of the SCARs will be visible in the listing page. 

3. Supplier can view responses for each of the SCAR issues by clicking View Responses, under the 

Actions tab. 

4. Suppliers can also Export all the responses for the SCAR with the help of Export under the Actions 

tab. 
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6.5.4 How to View Trend Analysis? 
 

Under My Performance, hover over Trend Analysis. A list of Customer Company will be provided. 

Select the customer company of your choice for which you want to view the development programs. 

Following page will be displayed: 

 

 
The Trend Dashboard is a heat map which displays graphical representation of data where the 

individual values are contained in a matrix and are represented as colours. The heat map will give you 

a quick overview of scorecards, trend report and KPI level scores for each supplier. 
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6.5.4.1 Linked Suppliers 

 
iPerform’s provides you with the ability to view the event-specific KPI scores (Hierarchical Score) for a 
Parent and Child Supplier. 

Here you can view scores for a Parent Supplier along with some or all of its Child Suppliers.  

The parent-child relationship is referred from iSupplier. The definitions of a Parent Supplier and Child 
Supplier remain the same as defined in iSupplier.  

The Parent may or may not be a participant of the event for which the Hierarchical Score was being 
calculated. 
 
1. To view linked suppliers to one particular supplier, click View Linked Supplier (highlighted in the 

image below). 

 

 

2. A popup will appear which will show all the suppliers linked to the selected supplier. 
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3. This popup will display the complete hierarchy of all the child suppliers of the selected supplier, 
and the parent of the selected supplier (if any). 

 

6.5.4.2 Trend Dashboard 

Year to Date (YTD) 

 
1. For a given supplier, under the Reports column, click Analyze > Trend Dashboard, you will be 

navigated to the following page: 
 

 
 

NOTE:  You can use the Change Supplier link to view the Trend Dashboard for your other supplier profile. 
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2. You can select the evaluation frequency from the drop-down list which offers options such as 

Monthly, Quarterly, Half Yearly, Yearly and YTD. 
 

 
 
NOTE:  For YTD option, the start date will be configured by your buyer and the end date will be today’s 
date. 
 

Scorecard View 

The "Scorecard View" section on this page represents data in Tabular manner with color coding. This 

scorecard view consists of Monthly scorecard represented by value and/or color. 
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Trend Report for Selected Supplier 

Below the scorecard section we have "Trend Report for Selected Supplier" section which displays the 

monthly trends of the supplier based on Scorecard mentioned in "Scorecard View" section. 

 

 

 

KPI View 

Below the "Trend Report for Selected Supplier" section, there is a section named "KPI View". In this 

section user will be able to view scores at KPI level for each scorecard. All the scorecards mentioned 

in scorecard section will be featured under KPI view. 

 

Under each scorecard user will have all the KPIs information associated with corresponding scorecard. 

The KPI view is similar to Scorecard view in following manner: 

 

▪ Same colour coding  
 

▪ Same tabular fashion data representation 
 

▪ Same month-wise data distribution. 
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Below the "KPI View" section, you will get the graphs which represent the data mentioned in the KPI 

view section. The graphs in this section are generated based on the data present in "KPI View" 

section. 

 

If page contains more than 12 scorecards and KPI’s more than a limit, they will be loaded on 

demand/scroll. 
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Excel Export 

 

User will also get an option to export the Trend Dashboard in excel format. There is a button on the 

top right side of the page named "Excel Export" for the user to export the trend analysis report in 

excel. 

 

The export data will be present in single worksheets. Worksheet will be named as “Trend Dashboard” 

and contain summary of the scorecards & KPI scores and their trend lines as shown in the attached 

excel. 
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With the help of this feature, users can perform their own arithmetic calculations on the exported 

data. Just as you start making changes to the exported data, the graphs will also get changed 

accordingly.  

 

There are hyperlink to take the user to the top of the excel export from each KPI View. There are 

hyperlinks to send the user to KPI View of a particular scorecard or send him to Scorecard view from 

KPI view. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.surveymonkey.com/r/2C3X2XK


 
 

 
  

Zycus Inc: 103 Carnegie Centre, Suite 201, Princeton, NJ 08540, Tel: +1 866-563-9219, Fax: 609 799 6047 

Zycus Supplier Network User Guide – Yellow 

Click Here to Give Feedback 

6.5.4.3 Hierarchical Score Dashboard 

 

Hierarchical score dashboard allows you to view the event-specific KPI scores (Hierarchical Score) for 

a Parent and Child Supplier. 

1. On the Analyze by Suppliers page, for a supplier go to the Analyze drop-down list, click the 
Hierarchical Score Dashboard option as shown below: 

 

 

2. You will be navigated to the following page: 
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3. The selected supplier’s name will appear by default in the Parent Supplier field. You can change 
the supplier on this page by using the Change Supplier link (highlighted in the image above). 

4. On clicking Change Supplier, following popup will appear: 

 

 

5. Select a supplier and click Done. The supplier will change. 
6. The selected supplier might have multiple child suppliers and their children. You can decide 

whose hierarchical score you want to view. To change the selection of child suppliers, click Edit 
Child Supplier Selection. 
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7. It will display the complete hierarchy of the selected supplier and its children and their children 
(if any) as shown below: 

 

8. Deselect a supplier if that supplier is not to be included in the Hierarchical Score calculation and 
click OK. 

9. Now click Select Event for which you want to calculate the Hierarchical Score. 

 

10. Event popup will appear.  
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11. Select an event and click Done. 
12. When an event is selected, the Scorecard Name will populate automatically in the field. You can 

choose which KPI you want to view. Click the drop-down against the KPI Name field. 
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13. On selecting the KPI, a new link List of Questions appears next to the KPI Name dropdown. Click 
on that link. A Question Details pop will appear. This will display all the questions in the KPI and 
a few other details pertaining to the questions. 

 

14. After selecting the KPI, the View Score button will become enabled. On click, you will be able to 
view Hierarchical Score dashboard for the selections made. 

 

 

Figure 1: Hierarchical Score Dashboard 
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15. The Hierarchical Score dashboard will display the KPI formula of the selected KPI in the 
configuration phase.  

16. The individual values for each question for each supplier are added.  

• For example, from above Figure 1: Hierarchical Score Dashboard, (Value of Question 2 for 
DELL INDIA + Value of Question 2 for DELL MUMBAI + Value of Question 2 for BANGALORE + 
Value of Question 2 for DELL BANGALORE DBA + Value of Question 2 for DELL DELHI) = Q2. 
Q3 to Q9 will be calculated in a similar manner.  

• The values Q2 to Q9 are then used in the “KPI formula for Hierarchical Score” in order to 
calculate the Hierarchical Score.  

• The Individual Parent Score as well as Hierarchical Score are also displayed.  

• As per the Figure 1: Hierarchical Score Dashboard, “DELL INDIA” is the parent supplier 
selected. Hence, the Individual Parent Score displayed will be that of DELL INDIA. 

• The side panel displays the list of other selected suppliers. The scores are also displayed in a 
graphical manner by the Hierarchical Score Graph.  

 
 

6.5.5 How to View Development Programs? 
 

Under My Performance, hover over View Development Programs. A list of Customer Company will 

be provided. Select the customer company of your choice for which you want to view the 

development programs. Following page will be displayed: 

 

 
 
1. If you are the owner of a development program, then you will be able to edit it. 
2. Click on the program title, you will be navigated to Program Summary page for that program. 
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3. Click , to view the performance report details. You will get following popup: 
 

 
 

4. Click Edit against the program title of which you are an owner. You will see following page: 
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NOTE: You will be able to view Program Details section of a Program. However Program Details section 
will be view only. You will not be able to make any edits in this section. 
 
5. You can upload a document or delete a document uploaded of your ownership. 
6. Click on the Milestones & Task tab.  
 

  
 

7. You will be able to see your milestones and tasks along with the internal user’s milestones and task. 
 

NOTE: You will be able to edit or delete a milestone and task if you are the owner. 
 
NOTE: You will be able to only add a task for internal member. Edit and Delete functionality will be 
greyed out. 
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8. Identify a milestone or task of which you are an owner and click on Actions drop-down.  
 

 
 
9. You will have an option to add new task, edit or delete. 
 

6.5.6 How to View Tasks and Milestones? 
 

From the side panel, under My Performance, hover over View Tasks and Milestones. You will see a 

list of customer company whose tasks and milestones you can view. Select a customer company of 

your choice. You will be navigated to following page: 

 

 

1. On this page, you will be able to view Active Tasks/Milestones, Overdue Tasks/Milestones, and 

Upcoming Tasks/Milestones. 
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6.5.7 How to View Reminders? 
 

From the side panel, under My Performance, hover on View Reminders. From the list of customer 

companies, select the customer company regarding which you want to view the reminder. You will 

be navigated to following page: 

 

 

1. You will be able to view all the reminders posted by the customer on this page. 

2. You will be able to view the reminder generated on date-time, supplier name, and description of 

the reminder. 

3. In the reminder description, the event name for which a reminder is created will be hyperlinked. 

Click on the event name and you will be navigated to the corresponding page. 
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6.5.8 How to View Notifications? 
 

From the side panel, under My Performance, hover on View Notifications. From the list of Customer 

Company, select the customer company regarding which you want to view the reminder. You will be 

navigated to following page: 

 

1. Here you will be able to view all the notifications created by the customer. 

2. You will be able to view the reminder generated on date-time, supplier name, and description of 

the notification. 

3. In the notification description, the event name for which a notification is created will be 

hyperlinked. Click on the event name and you will be navigated to the corresponding page. 
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6.6 My Events 

NOTE: The above-mentioned menu may or may not be available based on the access provided to you by 
customer. 

 

1. The My Events option allows the user to view the sourcing events and downloads.  
 

 
 

2. Hover on View Sourcing Events, you will be able to view the list of customer company. Select the 
customer company of your choice. Following page will be displayed: 

 

 
 
3. Select the supplier company from the drop-down on the top right corner. 
 

 
 

4. Under the Actions tab on the right, you can enter an open event or view the closed event. 
5. Hover over the View Downloads option, you will be able to view the list of customers. Select the 
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customer of your choice. Following page will be displayed: 
 

 
6. You will be able to download your response for a particular event. 
7. Under the Actions tab, you will have option to download your responses for particular event. 
 

6.6.1 How to Enter an Event? 
 

1. On the My Events page, click on Enter Event. 

 

 

2. After you enter an Event, you are navigated to the Confirm Participation page as shown: 
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3. You can read or download the Terms and Conditions, by clicking the Download button.  

 

4. Click on Accept to accept the terms and conditions. The following popup will be displayed: 

 

 

5. Click on Reject to reject the terms and conditions. A Rejection Comments pop up is displayed. 

 

6. Enter the comments for your rejection, and click on Reject. 

7. After you accept the terms and conditions, you can review RFx event.  

8. The RFx event consists of an overview of questions in the Non-Pricing Decision Factor and 

Pricing Section. 

9. You can view the details by expanding each section using the plus icon. 

10. You can close a section by using the minus icon. 
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11. Once you review these details, you can confirm participation by clicking Confirm Participation. 

12. On confirming the participation, you get the following popup:  

 

 

13. Once you review these details, you can decline participation by clicking Decline Participation. 

 

NOTE: If a supplier has declined participation, he can confirm the participation again. However, 

participation once confirmed cannot be declined. 
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14. To respond to the RFx, there are three tasks to follow: 

• Confirm/Decline Participation 

• Prepare Response 

• Submit Response 

15. Once you confirm your participation, you complete the first task off of the Supplier Checklist. 

 

 

16. Once you confirm participation, you are redirected to the Prepare Response page as shown: 

 

17. You can fill in the responses section-wise by clicking on Prepare Response corresponding to a 

particular section. 

18. The RFx editor page to prepare responses is displayed as shown: 
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19. Enter your response for a particular section.  

20. Click on Add Comments to enter comments for a particular question. Following pop up will be 

displayed: 

 

21. Write comment for respective questions and Save. 

22. After entering your response and comments for one section, click Save. It will save the 

respective sections with the information you have added. 
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23. On saving, the following popup is displayed:  

 

24. Similarly enter your response for other section and save it. 

25. iSource allows the user to export the non-pricing questions to MS Excel (.xlsx) to prepare 

responses offline in the spreadsheet itself, and once the responses are prepared, the same file 

can be imported in to the iSource tool. All the prepared responses will be uploaded & displayed 

in the tool. 
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26. Click Export > Save the file on your computer > Open the file > Respond to the questions > Save 

the file. 

 

27. To import the file, Click Import. 

 

27. Browse > Upload 

 

28. If the response consists of pricing section, fill the sections as per each line item. Shown below is 

an image of pricing table: 
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Bidding Options 

Partial Bid: Partial bidding will allow the supplier to bid for partial quantity. For example, if 

required quantity is 500, supplier can choose to bid for only 400. 

No Bid: If the supplier does not want to bid for a particular, he can check the box in “No Bid” 

column against that line item. 
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29. Users can also export the Items Table to MS Excel (.xlsx) to prepare offline responses in the 

spreadsheet. Once the responses are prepared, the same file can be imported into iSource tool. 

 

30. Click on Export > Save the file on your computer > Open the file > Fill your responses > Save the 

file. 

 

 

31. To import the file, Click Import. 

 

 

32. Browse > Upload 

 

 

32. Click on Submit Response on the Supplier Checklist. The Supplier Submit Response page is 

displayed:  
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33. Click on Submit Response, following popup is displayed: 

 

 

6.6.2 How Can I Recall My Response? 
 

1. A response to RFP and RFQ events can be recalled only if that event is open. 

2. Open the event whose response you want to recall, you will be redirected to following page:  

 

 

3. Click on Recall Response. Following popup will be displayed: 
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4. Once you recall an event, you will have to manually resubmit the response before the event 

closes for it to count. The Event Owner will be notified about the response recall action through 

email. 

5. When you recall an response, a Recall Response Reason popup will be displayed as shown: 

 

6. When you recall a response, the page will refresh and re-direct suppliers to the responses page 

where they can edit responses. 

 

 

7. The Recall Response button will be replaced with Re-Submit Response. 
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6.6.3 How Can I Negotiate Pricing? 
 

1. Once a Buyer chooses to conduct a negotiation, you will receive an email from the buyer inviting 

you to review the negotiated pricing and provide your approval for the same. In the email, along 

with the event details, you will also get your username and URL link for the event in the email. 

 

 

 

2. Once you login to the supplier portal, on the My Events page, the RFQ event for which the buyer 

wants to negotiate the pricing will be listed with the status Negotiation in Process. 

 

 

 

3. When you click on such event, there will be a new section called Approve Negotiated Pricing 

visible under the Supplier Checklist. 

 

4. The user can get to view the Original Bid Value, Negotiated Bid Value and % Change in Bid 

Value for each and every phase of negotiation. 
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5. After entering the event, under the Actions tab, supplier can either Accept, Reject, or Export 

Pricing Details. 

 

 

 

6. To approve, click on Approve from Actions drop-down list. 

 

 

7. In Acceptance Comment box, enter your comments for confirming the acceptance of negotiated 

price and click on Accept.  

8. Once you accept the negotiation, the status changes to Approved. 
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9. The status for the event on My Events page will change to Negotiation Accepted. 

 

10. To reject, click on Reject from Actions drop-down list. 

 

11. In the Rejection Comment box, enter your comment to confirm your rejection or negotiated 

price. 

12. Once you reject the negotiation, the status changes to Rejected. 

 

 

13. The status for the event on My Events page will get changed to Negotiation Rejected. 

 

14. To export the negotiation details, click on Export Details from the Actions tab and save the file 

on your computer. 

15. Open the .xlsx file to view the details. 

16. You can refer the summary sheet for details about negotiated pricing. 
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17. The next tab in the spreadsheet displays details on negotiated baseline cost for items in the item 

table. 
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6.6.4 How Can I Respond to Auctions? 
 

1. When a Buyer sends a bidding request for an auction, an auction event is created on the My 

Events page. 

 

 

2. Select the Auction you want to join, and then click Enter Event.  

 

Follow the steps from Enter an Event. 

 

6.6.5 How to Join Bidding? 
 

1. Click on Join Bidding in the Supplier Checklist section.  

 

2. Type of the auction can be either English Auction, Dutch Auction, or Japanese Auction. 

3. In English Auction under General Auction Settings, there are two auction types: 
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Option Description 

Forward Auction In forward auction, bidding starts at minimum 

acceptable price and increases with every new bid 

by a fix increment. 

Reverse Auction In reverse auction, bidding starts at acceptable 

price and decreases with every new bid by a fix 

decrement. 

 

4. After you click on Join Bidding, the Forward Auction page is displayed: 

 

 

5. In Dutch Auction, under General Dutch Auction Settings, there are two auction types: 

 

Option Description 

Forward Dutch Auction In Forward Dutch auction, buyer increases the cost, till supplier 

accepts the active bid cost.  

Reverse Dutch Auction In Reverse Dutch auction, buyer reduces the cost, till a supplier 

accepts the active bid cost.  
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6. After you click on Join Bidding, the Dutch Forward Auction page is displayed: 

 

7. In Japanese Auction, under General Japanese Auction Settings, there are two auction types: 

Option Description 

Forward Dutch Auction In forward auction, bidding starts at minimum acceptable price 

and increases with every new bid by a fix/variable increment. This 

is usually used for selling a commodity. 

 

Reverse Dutch Auction In reverse auction, bidding starts at acceptable price and 

decreases with every new bid by a fix/variable decrement. This is 

usually used for procuring a commodity. 
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6.6.5.2 Line Level Bidding 

 

1. When the bidding is at the line level, the following page will be displayed:  

  

 

2. Enter your bid amount at line level and click on Submit to submit the bid. 

3. The graph will show your bidding history since the start of auction. 
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4. To get information for particular time period, use the scroll bar (highlighted) to narrow down the 

time frame.  

6.6.5.3 Lot Level Bidding 

 

1. If the bidding is at Lot Level, the following page will be displayed: 

 

 

2. After changing the price, click on Submit Bid. The following popup will be displayed:  
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6.6.5.4 Rearranging the Columns 

1. The columns in the bidding item table can be rearranged as per supplier’s requirement. 

2. Use the        icon to rearrange the columns. 

 

3. Shown below are the columns of item table rearranged: 

 

4. Click Reset Column (highlighted) to undo rearranging the columns. 

 

6.6.5.5 Ranks 

The supplier ranks will be visible in the item table. Rank will be available per line item. 
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6.6.5.6 Japanese Auction Bidding Page 

 

Shown below is the overview of the Japanese Auction page. 

 

Japanese Auctions are carried out in lots. Every pricing lot in an event can have ‘n’ number of lots. 

For a given pricing lot, let’s take a look at how you can bid. 
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Responding to the Rounds of Pricing Lot 

 

1. The auction will progress one lot at a time. The auctions, once started will provide you with an 

Active Bid Cost for a lot whose response you have already submitted. Reviewing the Bid Cost 

and you can choose to Accept or Reject it. 

 

2. Upon acceptance, you will see the following popup. Click OK. 
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3. Your bid will be recorded and you will be able to proceed to the next round when it becomes 

active. 

 

4. Moving on the next round, similar to round 1, you can review the Active Bid Cost and choose to 

Accept or Reject the Bid. In the Supplier Acceptance Trends graph, the blue color bar signifies 

the last round. 

 

5. Once you have accepted your bid, you can wait for the next round to become active to 

participate. Here the Green bar in the Supplier Acceptance Trends graph denotes on-going 

event. 
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In case of rejecting an Active Bid Cost 

 

1. If you do not want to bid for any round, you can choose to Reject the bid. However please note, 

once rejected, you will not be allowed to enter any succeeding lots. 

 

2. Clicking Reject, you will see the following popup. Click OK. 
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3. In the scenario you have already rejected the bid even with the time remaining in the round to 

close, you can change his selection to ‘Accepted’. But once you have changed it to ‘Accepted’, 

you cannot change it back to ‘Rejected’. 
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6.6.6 How to Perform Bid Reconciliation? 
 

1. Bid reconciliation is performed at lot level when the auction status is changed to Closed. Bid 

reconciliation is initiated by the buyer.  

 

2. When buyer initiates Bid Reconciliation, you can view that in the Status of the auction as Bid 

Reco Open. 

 

3. Click on Enter Event. 

4. On entering the event, the following page will be displayed: 

 

5. Select Bid Reconciliation on the Supplier Checklist. You will be able to view the details about the 

Bid Reco. 
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6. Click on Prepare Response. Following page will be displayed: 

 

7. Change the prices in Pricing Information and click on Save. 

 

8. On saving revised price, a confirmation popup will appear. Click OK. The revised bid will be sent 

to the buyer. 
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6.6.7 From Where can I Access eForums? 
 

1. Click on Go to eForum. The following page will be displayed: 

 

 

2. You can either initiate an eForum by clicking New eForum or visit an existing eForum created by 

a buyer. 

3. Click Edit Notification to edit the notification that is sent to the buyer when you respond to the 

buyer’s message. The following popup will be displayed: 

 

 

4. Select an eForum and click on New Message.  

 

 

5. Following popup will be displayed. Write your message and click Post. Your message will be 

posted on eForum. 
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6. You will be able to see your message on the eForum. 

 

 

7. Click Reply.  
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8.  Respond To popup will be displayed: 

 

 

9. Type your message and click Post. The following popup will be displayed: 
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6.7 My Invoices 

NOTE: The above-mentioned menu may or may not be available based on the access provided to you by 
customer. 

 My orders option allows the user to view orders received from the customers. 

 

The My Invoices tab consists of three sub tabs: 

1. View Invoices 

2. Create PO Invoice 

3. Create Non PO Invoice 
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6.7.1 How to View Invoices? 
 

Using the View Invoices sub tab, the user can view invoices, PO and Non-PO Invoices created using 

ZSN. 

 

The User can perform the following operations using the View Invoices sub tab: 

1. Search Invoices 

2. Filter Invoices 

3. Sort Invoices 

4. View Invoices 

5. Edit Invoices 

 

6.7.1.1 Searching Invoices 

 

You can search for an invoice by entering the Invoice Number, PO Number or Customer name in the 

Search section. 

 

 

 

Enter the required search term in the Search Bar and click  or press ENTER. 
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6.7.1.2 Filtering Invoices 

 

You can filter the invoices based on the following parameters: 

• Invoice status: Select a status to view the invoices under that particular status. 

 

• Document Type: Select whether you want to view Invoice, Credit Memo, or both. 

 

  

https://www.surveymonkey.com/r/2C3X2XK


 
 

 
  

Zycus Inc: 103 Carnegie Centre, Suite 201, Princeton, NJ 08540, Tel: +1 866-563-9219, Fax: 609 799 6047 

Zycus Supplier Network User Guide – Yellow 

Click Here to Give Feedback 

• Document Origin: Select if you want to view the invoice or credit memo created by you or 

your buyer, or both. 

 

• Overdue: To view invoices whose payments are Overdue. 

 

• Invoiced between: Select start and end date using the  icon to view invoices dated between 

the selected date ranges. 

 

 

• Due Date between: Select start and end date using the  icon to view invoices whose due 

date lies between the selected date ranges. 

 

• Amount: Using the slider, select the start and end amount to view invoices whose amount lies 

in the selected amount range. OR Enter the start and end amount in the text boxes. 

 

Click Filter after selecting/enabling the required filters to filter the invoices. 

 

6.7.1.3 Sorting Invoices 

 

 
Click Clear Filters to deactivate all filters and display all invoices. 
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Besides the Due Date header, click on  to sort the invoices in ascending order and click on  to sort 
the invoices in descending order. 

 

 

 

6.7.1.4 Viewing Invoices 

 

To view a required Invoice: 
 

1. Navigate to the following location: Side Panel > My Invoices > View Invoices > Required Customer 
Company. 

 
2. Look for the required invoice using the Search, Filter or Sort options. 
 

3. For the required Invoice, click on the corresponding Invoice Number. 
 

 

4. For Invoices that are editable, the Update Invoices page is displayed. Invoices that cannot be edited 
are only viewed. 
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5. Clicking the Invoice Number, you will land on the following page: 
 

 
 

Note: On the Invoice details page, you will be able to view the payment details if any payment was 

made against an invoice. 
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Audit Trail for Invoice and Credit Memo 

 

Audit trail is available at the bottom of the invoice/credit memo document. It will display all the 

status change history and version updates made to the invoice/credit memo. Audit trail will show 

the following information: 

• Status 

• Date/Time 

• Version 

• Comments 

 

 

Viewing Milestone Invoices 

While viewing invoices with milestone items, suppliers will be able to view the milestone amount as 

shown below. The payments section will remain the same as payments are made at invoice level not 

milestone level.  
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6.7.1.5 Editing Invoices 

 

To edit an Invoice: 
 

1. Navigate to the following location: Side Panel > My Invoices > View Invoices > Required Supplier 
Company. 
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2. Look for the required invoice with Draft or Rejected status. 
 

3. Click on the  icon corresponding to the required invoice. 
 

 

4. Make the required changes in the invoice details, item details, taxes and so on. 
 

5. Perform any one of the following actions as required: 
 

A. Cancel: To discard the changes made in the invoice and exit. 
B. Save as draft: To save the changes made in the invoice and exit. 
C. Submit: To save the changes made in the invoice and submit the invoice for processing. 

 

 

 

6.7.1.6 Creating Invoice 

 

To create an Invoice for a Purchase Order: 
 

1. Navigate to the following location: Side Panel > My Invoices > Create PO Invoice > Required Customer 
Company. 
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2. Look for the required purchase order using the Search, Filter or Sort options. 
 

3. Click on the  icon from actions    menu corresponding to the required Purchase 
Order. 

 

4. Enter the required details on the New Invoice page. 
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NOTE: You can edit/add item name while creating direct invoices against blanket purchase order if 
the item name wasn’t mentioned by the buyer. The item name which you newly added will be sent 
to the buyer for approval in the invoice.  
 
NOTE: ZSN will restrict Suppliers from submitting amounts and UOM values that exceed customer 
supported decimal precision. Suppliers will be informed of their customer-specific decimal precision 
value for a given currency in the form of a Note, while creating a New Invoice, Flipping a PO to an 
invoice, or Updating an Invoice: 

 
 
NOTE: The customer’s decimal precision is set and enabled by the customer himself. If not enabled, 
the Note will not be displayed, and the portal will follow the default decimal precision.  
 
NOTE: Invoices not complying with this will be automatically rejected. Refer the following screenshot 
with auto-rejected Invoice: 
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5. You can edit the item name while creating an invoice against blanket purchase order if the item name 

is not mentioned. 

 

 
 

6. Select the items that are being shipped and enter their shipping quantity. 
 

 

7. Make the required changes to the Market Price and the Qty to be Invoiced. 
 

8. Perform the below required action as per requirement: 
 

A. Add/Edit Comments: 

i. Click on the  icon corresponding to the required item. 
ii. Enter or edit the comments as per requirement. 
iii. Click Save to save the comments. 
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B. Add/Edit Taxes: 

i. Click on the  icon corresponding to the required item. 
ii. Enter the Tax Name & Tax Rate, the Amount is auto calculated. 

 

 

iii. Add/Remove taxes as per requirements. 
 

 

 

iv. Click Save to save the entered taxes and their information. 

 

9. To enter the discount information for the invoice, click Modify present under the Item details section. 
 

 

10. The discount for an invoice can be entered in two aspects: 
 

A. Entire Invoice: 
 

1. Select the Discount an amount from the Entire Invoice option. 

 
Click on the  icon to add additional taxes OR click on the  icon to remove existing 
taxes. 

 

Select the Taxes Inclusive or Not applicable on this item? option if tax is not applicable for 
the item OR if the item cost is inclusive of all taxes. 

 
Click Remove all taxes to remove all taxes applied for the item. 

 

The Taxes input by the supplier will be automatically rounded off as per the customer 
supported decimal precision for the given currency. 
Example: If the tax rate is 7%, and taxable amount is 15.55, the tax amount is 1.0885.  If 
the decimal precision is 2, the tax amount will be rounded off to 1.09. This value will be 
used for all future calculations as well. Same rule goes for Discount. 
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2. Enter the exact discount amount to be set for the Invoice. 
 

 

3. Click Save to set the entered discount for the Invoice. 
 

B. Individual Items: 
 

1. Select the Specify discount for Individual items option 
 

2. Select the Discount Type for the required item 
 

3. Enter the required discount value for the item 
 

 

 

4. Click Save to set the entered individual item discounts in the Invoice. 
 

 

To enter a common discount % for all individual items, enter the Discount % and click Apply 
to all. 
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10. Enter the required tax information for the invoice. 
 

 

11. To enter common tax information for all individual items, select the required items and click Change 
multiple. 

 

 

 

12. Add and enter all the required tax information for the selected items. 
 

 
 

 

Check the Taxes Inclusive or Not applicable? option if taxes are inclusive or not applicable 
for the invoice. 
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13. Select the condition as to how the tax should be applied in the Apply To section. 
 

 

 

14. Click Apply to apply all specified taxes for the selected items. 
 

 

15. Enter all the required charges like Extra, Freight & Insurance Charges 
16. Enter the applicable Excise Duties for the Invoice 
17. Perform any one of the following actions as required: 
 

A. Submit: To save the changes made in the invoice & submit it. 
B. Save as draft: To save the changes made in the invoice and save it as a Draft Invoice. 
C. Cancel: To discard the changes made in the invoice and exit. 

 

 

18. If discounted payment terms are used, you will see an Early Payment Discount segment in your 
invoice document as highlighted below.  

 

 

19. Hovering on the Discounted Gross Total field, you will be able to view the base amount on which the 
discount is calculated.  

 
Click on the  icon to add additional taxes OR click on the  icon to remove existing 
taxes. 

 
Click Remove all taxes to remove all taxes applied for the item. 

 

Invoice can also be created using the Create Invoice option under the Actions menu on the 
View PO page for the respective Purchase Order. 
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20. For example, in the screenshot above: 

• Item Sub-total = 40.00,00 

• Discounted Gross Total = Gross Total - Early payment discount  

• Gross Total = 42.000,00 (item sub-total + taxes) 

• Early Payment Discount = 90% on USD 40.000,00 = USD 36.000,00  

• Hence Gross Total - Early payment discount = 42.000,00 – 36.000,00 = 6.000,00 
 

21. If the discounted gross total is less than 0, you will see the following message on the screen: 
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6.7.1.7 Exporting Invoice Details  

 

From this listing page, you have an option to download all details of your company’s invoices. To 

download the invoice details, follow the steps below: 

1. Navigate to Invoice listing page from Side Panel > My Invoices > View Invoices > Customer 

Name. You will land on the following page: 

 

 

2. To export the invoice details, click Export as highlighted in the image below:  
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3. Clicking Export, you will see the following popup which will notify you that data export is in 

progress and you will be notified through an email once the file export is complete. Click Ok. 

 

4. Once the file is ready, you will receive the exported file (attached) to your registered email ID as 

shown below: 

 

5. Open the file to view your invoice details: 

 

Note: The data exported will be as per the filter applied on the listing page. You will be able to view 

the applied filters in the exported file as well. The maximum limit on the number of records exported 

is 15,000. Records beyond 15,000 will not be part of the exported file. 
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6.7.2 How to Create a PO Invoice? 
1. To create a PO invoice, from the side panel, under My Invoices, click Create PO Invoices. 

2. Select a customer for whom you want to create a PO invoice, for example eProc2014. 

 

 

3. You will see the following popup. This popup will have a list of PO’s which you can select to 

create an invoice. 

Note: Only the PO’s with confirmed status will be available in this popup. 

 

4. Select a PO from the list; you can also search for a PO by typing the PO number in the search 

box. Click Done. 
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5. You will be navigated to the following page: 

 

6. All the necessary PO information will be filled in the invoice by default such as: 

• Invoice-To Address 

• Payment Terms 

• Bill-To Address 

• Ship-To Address 

• Bank Details (if required, you can change the bank details from the drop-down menu) 

Note: If the supplier uses cXML invoices, default bank details will be used. 

7. You will also be able to select Remit to Address for the PO invoice which will specify the address 

type, for example Headquarters as HQ. 

8. Enter all the required information such as Invoice No., Invoice Date, Remit to Address, and 

Ship-From Address. 

9. Select the items you want to invoice by checking the box against the item name. You can select 

all items by checking the box as shown below: 

 

Note: If a line item has “Receive by: Amount” on the PO; Market Price, Unit Price, and UOM fields should have 
the value N/A. 

The “Ordered Qty/Amt” will be reflected as the “Total Price” for that line item. 
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10. There may be Milestone items in the PO. These will be reflected with the milestone flag 

 

11. Suppliers will be able to enter invoice qty/amt for against each field. These fields will be editable 

once a corresponding milestone is selected  

12. If the invoice is already created for a milestone the invoice qty/amt will be defaulted to show the 

remaining amount 

13. You can add taxes to the line items by clicking the  icon. You will see the following popup: 

 

14. Suppliers will now be able to include negative taxes while generating an Invoice on the Supplier 

Network. While adding taxes at the header/line level on an invoice, suppliers can simply put in 

the “-ve” sign to indicate that it is a negative tax. 

15. To add tax, select Tax Type and Tax Name from the drop-down list. Based on this selection, 

modify the Tax Rate % as per the norms. 

16. You can also apply taxes at header level as shown in the image below: 

 

17. Both –ve tax rate and/or –ve tax amount can be entered. –ve tax rate/amount indicates 

witholding taxes. 

https://www.surveymonkey.com/r/2C3X2XK
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18. When –ve taxes are added, the discounted item total, on which the tax is applicable, can be 

edited. 

 

 

Note: You can type a tax name which is not present in the drop-down list. 

Note: If the locale of your profile is set to the language of your choice, the tax-type and tax-rate 

will also be reflected in the same language. 

19.  After you complete entering all information, click Submit. 
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6.7.2.2 Side by Side Panel 

 

Side by Side panel is a different view of PO invoice creation page.  

Side by Side panel allows you to view the uploaded files and fill the invoice simultaneously. It 

separates the web page into two parts with image on the left and invoice on the right. Following is 

an image of side by side panel: 

 

 

6.7.2.3 Understanding Side by Side Panel 

 

1. Here you can see the uploaded document while creating a PO invoice. 

2. There will be tools present above the uploaded document. 

3. Use  to view/hide the image thumbnails. 

4. Use  to zoom out, view actual size, and zoom in the image. 

5. Use  to rotate the image clockwise and anti-clock wise. 

6. Use  to view the document in new tab. 

7. Use  to expand or collapse invoice filling. 

8. Use  to add more documents. Select a file, click Done. 
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Note: As a supplier you can confirm PO and create Invoice from email notifications by clicking 

Confirm and Create Invoice. 

When you confirm a PO from mail, you will be redirected to the Create Invoice page where you can 

flip details directly in to the invoice and submit the invoice. 

This will be applicable for both registered and unregistered users. 

In case the PO is already confirmed by another user, then you will be directly taken to the create 

invoice page. 

In case the PO is already confirmed and fully invoiced, then you will see the following message: 

“The PO has been already fully invoiced by another user from your organization. You can now 

login/Register to track the status of the invoice.” 
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6.7.3 How to Create a Non PO Invoice? 
 

Note: You can create a Non PO Invoice if it is enabled by your buyer. If it is not enabled, you will not see the 
option ‘Create Non PO Invoice’. 

If your company profile is put on hold by your customer, then you won’t be able to create a Non-PO Invoice for 
that customer. 

Suppliers can create a non PO invoice from their end for a given customer. The following page shows 

the Non PO Invoice creation page. 

  

 

NOTE: The customer-specific decimal precision rule applies to Non PO invoices as well. 

To create a Non-PO Invoice: 
 

Navigate to the following location: Side Panel > My Invoices > Create Non PO Invoice > Required 

Customer Company. 

1. Select and/or enter all the required Customer Details. 

https://www.surveymonkey.com/r/2C3X2XK


 
 

 
  

Zycus Inc: 103 Carnegie Centre, Suite 201, Princeton, NJ 08540, Tel: +1 866-563-9219, Fax: 609 799 6047 

Zycus Supplier Network User Guide – Yellow 

Click Here to Give Feedback 

   

 

Note: As a supplier, you have the flexibility of adding the Buyer and Requester Email ID. 

2. Enter all the required Organization Unit details. 

 

3. Select and/or Enter all the required Invoice Details. 

 

Note: If the supplier uses cXML invoices, default bank details will be used. 

4. Add the required attachments for the Non PO Invoice. 

 

https://www.surveymonkey.com/r/2C3X2XK


 
 

 
  

Zycus Inc: 103 Carnegie Centre, Suite 201, Princeton, NJ 08540, Tel: +1 866-563-9219, Fax: 609 799 6047 

Zycus Supplier Network User Guide – Yellow 

Click Here to Give Feedback 

Note: Remit to Address will be classified as defined address types such as Remit to Address/ 

Headquarters as mentioned in your supplier company profile. 

 

5. Click on Add item to add an item to the Non PO Invoice. 

 

6. Enter all the required Item Details under the Item tab, such as: 

• Line No. 

• Short Description 

• Product Category 

• Item Type 

• Invoice by 

• Amount 

• Market Price 

• Quantity & UOM 

  

Note: If the “Invoice by” option is set to Amount, then: 

Market Price, Unit Price and UOM fields will be disabled, with value as N/A. 
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A new mandatory field, “Amount”, will become visible. 

The value entered in the Amount field will be populated in the Total Price and Invoice Qty/Amt or Credit 
Qty/Amt column value. 

7. Attach the required files and mention the required comments under the Attachments & 

Comments tab. 

 

  

8. Add and enter all the required tax information for the item being added to the Non PO Invoice. 

 

 

9. Suppliers will now be able to include negative taxes while generating an Invoice on the Supplier 

Network. While adding taxes at the header/line level on an invoice, suppliers can simply put in 

the “-ve” sign to indicate that it is a negative tax. 

10. You can also apply taxes at header level as shown in the image below: 
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11. Both –ve tax rate and/or –ve tax amount can be entered. –ve tax will indicate withholding taxes. 

12. When –ve taxes are added, the discounted item total, on which the tax is applicable, can be 

edited. 

 

 

Note: You can type a tax name which is not present in the drop-down list. 

Note: As mentioned earlier, ZSN will automatically round off all tax values as per customer 

supported decimal precision for the given currency. 

13. After you complete entering all information, click Submit. 

14. The Non PO invoice you created will be visible under My Invoices listing page. 
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6.7.3.2 Side by Side Panel 

 

Side by Side panel is a different view of Non PO invoice creation page.  

Side by Side panel allows you to view the uploaded files and fill the invoice simultaneously. It 

separates the web page into two parts with image on the left and invoice on the right. Following is 

an image of side by side panel: 

 

 

6.7.3.3 Understanding Side by Side Panel 

 

1. Here you can see the uploaded document while creating a non-PO invoice. 

2. There will be tools present above the uploaded document. 

3. Use  to view/hide the image thumbnails. 

4. Use  to zoom out, view actual size, and zoom in the image. 

5. Use  to rotate the image clockwise and anti-clock wise. 

6. Use  to view the document in new tab. 

7. Use  to expand or collapse invoice filling. 

8. Use  to add more documents. 

 

https://www.surveymonkey.com/r/2C3X2XK


 
 

 
  

Zycus Inc: 103 Carnegie Centre, Suite 201, Princeton, NJ 08540, Tel: +1 866-563-9219, Fax: 609 799 6047 

Zycus Supplier Network User Guide – Yellow 

Click Here to Give Feedback 

6.7.4 How to Create Credit Memo? 
 

1. Suppliers can create credit memos against the previous orders or without a reference to any order 

as well. 

 

2. The users will have the option to create a credit memo right from the side panel menu. 

3. There are two types of credit memo anyone can create: 

• Credit Memo against a PO(Purchase Order) 

• Credit Memo without reference 

4. Credit Memo against a PO is generally created when the supplier would like to credit the 

supplier against any previous order received from the customer. 

5. Credit Memo without reference is created when the supplier would like to credit any previous 

purchase without any particular Purchase order. 

6. The supplier can select create option from the Side panel menu or they have the option from 

the Invoices listing. 
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Note: While creating Credit Memos the supplier will be able to see an option to add Return Freight 

& Extra charges if the settings to allow so have been enabled from the buyers end.  

6.7.5 How to create Credit Memo Against a PO 
 

1. To create a Credit Memo against a PO the user can select the Create option from the side panel 

menu or the option from the Invoices listing page. 

2. Once the user clicks on create against a PO then he will be redirected to the Purchase Orders 

listing where the User can select + Credit Memo against the order which he would like credit. 
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7. The user can select Actions > + Credit Memo against the PO. 

Note: You can create credit memo against only those PO’s which are partially or fully invoiced. 

8. The user can credit the customer up till the invoiced quantity/amount. 

 

9. Once the user clicks +Credit Memo they will be taken to the below page where he will be able to 

add the credit memo details. 

 

NOTE: Credit Memo will automatically validate values as per customer specific decimal precision. 

10. Add mandatory credit memo details such as: 

• Credit Memo Number 

• Credit Memo Date 
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• Remit to Address 

11. Under the Item Details section, select the items for which you want to create a credit memo. 

 

You can view/update mandatory information such as: 

• Line No. 

• Short Description 

• Product Category 

• Item Type 

• Invoice By 

• Amount 

• Market Price 

• Quantity & UOM 

• Milestone Name (only for items with Milestone flag) 

• Milestone Number (only for items with Milestone flag) 

 
Note: The values of the above fields for Milestone items will be flipped from the PO just like they 
do from all line items. Actions will be available at line level and not at milestone level. The 
apportionment of other charges, freight, discount for the items with milestones will have no 
impact on any milestone.   

 

12. You can add taxes to the line items by clicking the  icon. You will see the following popup: 
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13. Suppliers will now be able to include negative taxes while generating an Invoice on the Supplier 

Network. While adding taxes at the header/line level on an invoice, suppliers can simply put in 

the “-ve” sign to indicate that it is a negative tax. 

14. To add tax, select Tax Type and Tax Name from the drop-down list. Based on this selection, 

modify the Tax Rate % as per the norms. 

15. The user also has options to create an item-less credit memo against a PO. 

 

 

16. You can also apply taxes at header level as shown in the image below:  
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17. Add Taxes to the line items. To add tax, select Tax Type and Tax Name from the drop-down list. 

Based on this selection, modify the Tax Rate % as per the norms. 

18. Both –ve tax rate and/or –ve tax amount can be entered. –ve tax rate/amount indicates 

withholding taxes. 

19. When –ve taxes are added, the discounted item total, on which the tax is applicable, can be 

edited. 

 

Note: You can type a tax name which is not present in the drop-down list. 

Note: Taxes input will be rounded off as per customer-specific decimal precision 

Note: If the locale of your profile is set to the language of your choice, the tax-type and tax-rate 

will also be reflected in the same language. 

20. After you complete entering all information, click Submit. 

 

Viewing Credit Memos with Milestone items 

 

The credit memos created with have milestone details displayed for the items as shown below: 
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6.7.6 How to create Credit Memo without Reference 
 

1. The user can also create a credit memo without reference. 

2. From the side panel, go to My Invoices > Create Credit Memo without Reference > select your 

customer. 

Note: If you do not see your customer company listed here, please get in touch with your contact at your 
customer company. 

If your company profile is put on hold by your customer, then you won’t be able to create a Credit Memo 
without PO Reference for that customer. 

3. In case the user selects create without reference then the user will be directly taken to the credit 

memo creation page where he will be able to add the line level details or even create an item 

less credit memo similar to the PO type creation. 

 

Note: Here you have a flexibility to add Requestor Email ID. 
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4. The credit memo without reference, the user will have to add all the details such as: 

• Customer Details  

• Organization Unit information 

• Credit Memo Details  

• Item Details 

• Taxes on the items (here you can add –ve taxes to indicate withholding taxes) 

5. Under the Item Details section, select the items for which you want to create a credit memo. 

 

You can view/update mandatory information such as: 

• Line No. 

• Short Description 

• Product Category 

• Item Type 

• Invoice By 

• Amount 

• Market Price 

• Quantity & UOM 

6. You can add taxes to the line items by clicking the  icon. You will see the following popup: 

 

7. Suppliers will now be able to include negative taxes while generating an Invoice on the Supplier 

Network. While adding taxes at the header/line level on an invoice, suppliers can simply put in 

the “-ve” sign to indicate that it is a negative tax. 

8. To add tax, select Tax Type and Tax Name from the drop-down list. Based on this selection, 

modify the Tax Rate % as per the norms. 
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9. The user also has options to create an item-less credit memo against a PO. Checking this box will 

grey out the item and the same credit memo can be used as item-less credit memo. 

 

10. You can also apply taxes at header level as shown in the image below:  

 

11. Add Taxes to the line items. To add tax, select Tax Type and Tax Name from the drop-down list. 

Based on this selection, modify the Tax Rate % as per the norms. 

12. Both –ve tax rate and/or –ve tax amount can be entered. –ve tax rate/amount indicates 

withholding taxes. 

13. When –ve taxes are added, the discounted item total, on which the tax is applicable, can be 

edited. 
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Note: You can type a tax name which is not present in the drop-down list. 

Note: Taxes input will be rounded off as per customer-specific decimal precision 

Note: If the locale of your profile is set to the language of your choice, the tax-type and tax-rate 

will also be reflected in the same language. 

14. Once the details are added, submit the credit memo for apportionment. 
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6.7.7 Credit Memo handling on ZSN 
 

1. Once the user creates a credit memo against a PO, then that invoiced quantity/amount will be 

credited which will allow the user to create invoices against the PO for the same quantity again. 

2. The credit memo once submitted will be sent to eInvoice for AP manager to review, where the 

status of Credit Memo will be Ready for Apportionment.  

3. Once the Credit memo is adjusted against any invoice that needs to be paid for the supplier, 

then the credit memo will be used and the status will be Apportioned on ZSN. 

4. The user will also have option to create credit memo from My Uploads section using already 

uploaded scanned file. 

 

6.7.8 How to View Uploads in eInvoice? 
 

1. The View Uploads option allows the user to view the documents uploaded by you for a 

customer. 

 

NOTE: Files under uploads will be visible only to you and not to your customer. 

 

2. Click on My Invoices. Hover over View Uploads. You will be able to see list of customers for 

which you can check your uploads. 
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3. Select the customer for which you want to view the upload. You will be redirected to the 

following page: 

 

 

4. Click on Actions drop-down menu to: 

a. View the upload 

• You can upload files with format .jpg;*.jpeg;*.gif;*.png;*.bmp;*.pdf. 

• You can filter the files as Pdf or Image. 

• Click on the file to preview it. The file will be displayed as shown below: 

 

b. Create PO Invoice 

c. Create Non-PO Invoice 
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d. Create Credit Memo against PO 

e. Create Credit Memo without reference 

f. Add as an Attachment:  

• When you lick Add as Attachment, it will redirect you to the PO listing page, where you 

can attach the file to an existing PO which is in Draft stage or Rejected. 

• Click on the PO to which you want to attach the file, you will see the following popup: 
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6.7.9 How to View Payments in eInvoice? 
You will be able to see the payment status against the invoices you submit via ZSN in case your 

customer updates this information. 

 

To view the payments, Navigate to the following location: Side Panel > My Invoices > View Payments 

> Required customer company.  

 

 

1. You will be navigated to the following page: 
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2. On the Payments page, you will be able to view following details for each payment:  

• Payment Reference Number 

• Customer 

• Payment date 

• No of Invoices Paid (hover on , the invoices number will be showed) 

• Payment amount - currency to be appended in front of the amount 

• Payment status 

 

3. The User can perform the following operations using the View Invoices sub tab: 

 

• Search Payments 

• Filter Payments 

• Sort Payments 

• View Payments 

6.7.9.1 Searching Payments 

1. You can search for payments by Payment Number and Customer on the Payments listing page 

as shown below: 
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6.7.9.2 Filtering Payments 

 

You can filter the payments based on the following parameters: 

• Payment status: Select a status to view the invoices under that particular status. 

 

• Payment Date between: Select start and end date using the  icon to view payments dated 

between the selected date ranges. 

 

 

• Amount: Using the slider, select the start and end amount to view payments whose amount 

lies in the selected amount range. OR Enter the start and end amount in the text boxes. 
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• Click Filter after selecting/enabling the required filters to filter the invoices. 

 

6.7.9.3 Sorting Payments 

1. You can sort the entries on Payments by: 

• Customer Name 

• Payment Number 

• Payment Date 

• Amount 

 

Note: The entries on the Payment page will be sorted in descending order. 
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6.7.9.4 Viewing Payments  

1. For a given payment, under the Actions column, click View to view the payment details. You will 
be navigated to the following page: 

 

2. You can also view the payment details page by click on the Payment Reference Number. 

Note: You can also add Payments card on the ZSN home page. 
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6.7.9.5 Exporting Payment Details  

 

From this listing page, you have an option to download details of all your payments. To download 

the payment details, follow the steps below: 

1. Navigate to Payment listing page from Side Panel > My Orders > View PO > Customer Name. 

You will land on the following page: 

 

2. To export the Payment details, click Export as highlighted in the image below:  

 

3. Clicking Export, you will see the following popup which will notify you that data export is in 

progress and you will be notified through an email once the file export is complete. Click Ok. 

 

4. Once the file is ready, you will receive the exported file (attached) to your registered email ID as 

shown below: 
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5. Open the file to view your Payment details: 

 

Note: The data exported will be as per the filter applied on the listing page. You will be able to view 

the applied filters in the exported file as well. The maximum limit on the number of records exported 

is 15,000. Records beyond 15,000 will not be part of the exported file. 
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6.7.10 Marking Filters as Favorites  
 

ZSN has enabled the option for the Suppliers to create a filter and save as a favorite. The user can 

also set one of the filters as their default view. By setting a default view, the listing page will display 

the entries based on the filters selected. 

To mark filter as favorite, 

1. Select the filter parameters from the left panel and click the Save as Favorite Filter button as 

shown in the image below: 

 

 

2. Once you choose to save a filter, you will have to name it as shown below: 

 

 

3. To set a filter as default, check the box as shown in the image above. Whenever the user will 

visit this page, the data will be filtered based on the selected parameters.  

4. Saved filters will be available in the left panel of the listing page as shown below: 
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5. You can have only one filter set as default. If you make another filter as default, then it will 

override the existing favorite filter and you will be notified as shown below: 

 

 

6. Click Yes if you wish to override the existing default filter. 

7. To remove a filter from favorite, go to the left panel and click Edit against a filter. 
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8. Uncheck the box against Save as Default and click Save. 

9. If you wish to delete a filter, click Delete in the popup shown above. 

 

6.8 My Orders 

NOTE: The above-mentioned menu may or may not be available based on the access provided to you by 
customer. 

The My Orders option allows the user to view Orders sent you by your customers. 

 

Note: You can view the Deliver To location on the PO listing page itself. 
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The User can perform the following operations using the My Orders tab: 

2. Search Orders (Refer Searching Invoices) 

1. Filter Orders (Refer Filtering Invoices) 

2. Sort Orders (Refer Sorting Invoices) 

3. Confirm/Reject Orders 

4. View Orders (Refer  

5.  

6. Viewing Invoices) 

7. Send Shipment Notice for the Orders (Refer How to Create a Shipment Notice?) 

8. Send Invoices for the Orders (Refer  

9.  

10. Creating Invoice) 

11. Download Order Details as PDF (Refer Download PO as PDF) 

12. Preview PO cXML (Refer  

13. Preview PO cXML) 

 

6.8.1 How to Confirm/Reject a Purchase Order? 
 

1. Navigate to the following location: Side Panel > My Orders > View Orders > Required Customer 
Company. 

 

 

 

2. Look for the required purchase order using the Search, Filter or Sort options. 
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3. Perform any one of the following actions as per requirement: 
 

A. Approving PO: 

1. Click on the  icon corresponding to the required Purchase Order to 

approve the PO. 

 

 

 

2. Select the Estimated Delivery Date for the Purchase Order. 

 

3. Enter the required comments. 

 

4. Click Confirm PO to approve the PO. 

 

B. Rejecting PO 

1. Click on the  icon corresponding to the required Purchase Order to 

reject the PO. 
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2. Enter the required comments. 

3. Click Reject PO to reject the PO. 

 

Download PO as PDF 

 
1. Navigate to the following location: Side Panel > My Orders> View Orders> Required Customer 

Name.  

 

2. Look for the required PO using the Search, Filter or Sort options. 

3. Click on the  icon from  menu corresponding to the required Invoice. 
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4. Click on the menu and select Download as PDF. 

Preview PO cXML 

 

1. Navigate to the following location: Side Panel > My Orders> View Orders > Required Customer 
Company. 

 

 

2. Look for the required PO using the Search, Filter or Sort options. 
 

3. Click on the PO number to view PO. 
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4. Click on the Actions menu and select Preview PO CXML. 
 

PO with Payment Milestones 

 

A PO with items with Milestone amount will be sent to ZSN. Suppliers will be able to Confirm/ Reject 

it from ZSN. After the PO is created and shared it will show up with corresponding section of 

milestone payments below the line items. To help differentiate the items with the billing plan linked 

to them, there will be a milestone flag next to name of the item.  
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6.8.2 How to Create a Shipment Notice? 
 

To create a Shipment Notice for a Purchase Order: 
 

1. Navigate to the following location: Side Panel > My Orders> View Orders > Required Customer 
Company 

 

2. Look for the required purchase order using the Search, Filter or Sort options 
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3. Click on the  icon under actions  corresponding to the required Purchase Order. 
 

4. Enter the required details on the New Shipping Notice page. 
 

 

 

5. Select the items that are being shipped and enter their shipping quantity. 
 

https://www.surveymonkey.com/r/2C3X2XK


 
 

 
  

Zycus Inc: 103 Carnegie Centre, Suite 201, Princeton, NJ 08540, Tel: +1 866-563-9219, Fax: 609 799 6047 

Zycus Supplier Network User Guide – Yellow 

Click Here to Give Feedback 

 

 

6. Perform any one of the following actions as required: 
 

A. Cancel: To discard the changes made in the shipment notice and exit. 
B. Save as draft: To save the changes made in the shipment notice and exit. 
C. Submit: To save the changes made in the invoice and submit the shipment notice for 

processing. 
 

 

  

 

Shipment notice can also be created using the Create Shipment Notice option under the 
Actions menu on the View PO page for the respective Purchase Order. 
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6.8.3 How to Create Direct Invoice against a Blanket Purchase Order? 
 

The supplier can create an invoice against blanket order if the customer has given access to 

suppliers. Or else the suppliers can create invoice against release orders if the customer hasn’t given 

access. In case of no access, the supplier can still view the blanket order for their reference. 

 

3. On the landing page, select Purchase Order from the Card Library. 

 

4. Click on View More to view the list of PO. You will be redirected to following page: 
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5. On the left side panel, check on the filter in PO Type as Blanket and click on Apply Filter. All the 

blanket purchase orders will be listed. 

6. Select the BPO against which you want to make an invoice, click on Actions drop-down menu, 

and select + Invoice. 

 

7. Following page will be displayed. Fill in the details in the invoice. 

 

8. Once you complete filling the invoice, you can submit or save the invoice as draft. 
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6.8.4 Marking Filters as Favorites  
 

ZSN has enabled the option for the Suppliers to create a filter and save as a favorite. The user can 

also set one of the filters as their default view. By setting a default view, the listing page will display 

the entries based on the filters selected. 

To mark filter as favorite, 

1. Select the filter parameters from the left panel and click the Save as Favorite Filter button as 

shown in the image below: 

 

2. Once you choose to save a filter, you will have to name it as shown below: 

 

 

3. To set a filter as default, check the box as shown in the image above. Whenever the user will 

visit this page, the data will be filtered based on the selected parameters.  

4. Saved filters will be available in the left panel of the listing page as shown below: 
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5. You can have only one filter set as default. If you make another filter as default, then it will 

override the existing favorite filter and you will be notified as shown below: 

 

6. Click Yes if you wish to override the existing default filter. 

7. To remove a filter from favorite, go to the left panel and click Edit against a filter. 

 

8. Uncheck the box against Save as Default and click Save. 

9. If you wish to delete a filter, click Delete in the popup shown above. 
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6.8.5 Exporting PO Details  
 

From this listing page, you have an option to download details of all your PO’s. To download the PO 

details, follow the steps below: 

1. Navigate to PO listing page from Side Panel > My Orders > View PO > Customer Name. You will 

land on the following page: 

 

2. To export the PO details, click Export as highlighted in the image below:  
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3. Clicking Export, you will see the following popup which will notify you that data export is in 

progress and you will be notified through an email once the file export is complete. Click Ok. 

 

4. Once the file is ready, you will receive the exported file (attached) to your registered email ID as 

shown below: 

 

5. Open the file to view your PO details: 
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Note: The data exported will be as per the filter applied on the listing page. You will be able to view 

the applied filters in the exported file as well. The maximum limit on the number of records exported 

is 15,000. Records beyond 15,000 will not be part of the exported file. 

 

6.9 My Catalogs 

NOTE: The above-mentioned menu may or may not be available based on the access provided to you by 
customer. 

If your company profile is put on hold by your customer, then you won’t be able to create a Catalog for that 
customer. 

 

The My Catalogs option allows the user to: 

• View catalogs uploaded by you for a customer 

• Create your new catalog 

 

To view the catalogs, access the side panel and go to My Catalogs > View Catalogs. You will land on 

the following page: 

 

 

NOTE: When a catalog is first uploaded by the customer or created by supplier, the version will be V1 by 
default. 
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The User can perform the following operations using the View Catalogs tab: 

1. Search Catalogs (Refer Searching Invoices) 

2. Filter Catalogs (Refer Filtering Invoices) 

3. Sort Catalogs (Refer Sorting Invoices) 

4. View Catalogs (Refer  

5.  

6. Viewing Invoices) 

7. Upload New Catalog 

8. Edit Existing Catalogs 

9. Delete Catalogs 

 

Note: For the catalogs that are being uploaded in the background and be reviewed by clicking 

Catalog Upload Status option as shown below: 
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6.9.1 How to Upload a Catalog? 
 

Uploading a Catalog in ZSN consists of the following Steps: 

Step 1: Catalog Details 

 

Step 2: Upload Catalog 

 

a. Online Creation 

b. Offline Upload (CSV, CIF 3.0, cXML, Excel, ZIP) 

i. Upload File 

ii. Map Columns 

iii. Validate 

iv. Classify 

 

Step 3: Item Details 

 

Step 4: Validate and Publish 

 

To upload a Catalog in ZSN: 
 

Navigate to the following location: Side Panel > My Catalogs > Create New Catalog > Required 

Customer Company. 
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Step 1: Catalog Details 

 

1. Enter the mandatory fields such as Catalog Name and Supplier Company. 
 

2. Enter the Buyer Email Id if you wish to share your catalog with any buyer. 
 

NOTE: if the Buyer Email Id does not belong to buyer organization, then the system will display following 
error message: 

 
 

3. Select the Catalog Taxonomy as Standard Taxonomy or Custom Taxonomy. 
 

 
 

4. If you select Custom Taxonomy there will be no validations on category. 
 

NOTE: Custom Taxonomy may or may not be supported by your buyer. Please inform your buyer in case 
you are uploading a taxonomy different from buyers. 
 

5. Click Continue. 
 

https://www.surveymonkey.com/r/2C3X2XK


 
 

 
  

Zycus Inc: 103 Carnegie Centre, Suite 201, Princeton, NJ 08540, Tel: +1 866-563-9219, Fax: 609 799 6047 

Zycus Supplier Network User Guide – Yellow 

Click Here to Give Feedback 

Step 2: Upload Catalog 

 

Select the required Catalog format for upload OR click Create under Create New Catalog. Refer the 

following screenshot: 

 

  

Online Creation 

 

1. On the Step 2 page, click on the Create button under Create New Catalog. This will redirect you 

to the following page: 
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2. Click + Add new item to add items to the Catalog. 
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NOTE: ZSN prevents customers from adding UOM or Price which is not supported as per 

customer supported UOM and decimal precision for currency. It will show a warning as shown in 

the following screenshot: 

 

3. Enter all the required information about the item to be added in the Catalog such as: 

• Supplier Part ID 

• Short Description 

• Product Category 

• UOM 

• Price 

• Currency 

4. You can also choose to De-activate an item if required. 

5. Select the Item Image by clicking Select File OR enter the URL of the image. 

6. Click Add to add the item with the entered details in the Catalog. Similarly, add/edit/delete all 

items in the Catalog as per requirement. 

7. Once the items are added, you can review them as shown below: 
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Note: Highlighted section shows the status of items of whether they are active or inactive. 

Note: If Decimal Precision is not followed for items uploaded in the catalog, ZSN will display an error 

as shown below: 

 

8. Click Continue to proceed to Step 4: Validate & Publish. Following page will be displayed: 
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9. Enter the Validity (From-To) of your catalog using the date picker.  

10. You can also share this catalog with your customers. Check the box against Select to share this 

catalog with customers. On checking the box, a table will appear. 

 

11. For the selected customer, Customer Name will be auto-populated. You can enter the Discount 

you want to offer to the company. You can also mention the Validity of the catalog for the 

customer. 

12. Click Submit. You will get following popup: 
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13. Your catalog will be displayed in catalog listing page.  

 

Offline Creation 

 

1. On the Step 2 page, select the required File Upload Format. 

 

2. Download the sample Catalog file for the selected format using the below highlighted link. 

 

3. Download, edit & save the downloaded sample catalog file as per requirements. 

4. Click Select File and browse and select the edited and saved catalog file. 

 

NOTE: You can download the sample template for ZIP file on you system for reference. 
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NOTE: Validations will be in place when supplier enters any currency, UOM, location or address that 

are no longer supported by the buyer. 

NOTE: Catalogs uploaded using all bulk upload methods will be validated for Decimal Precision 

against UOM and Item Price as per the currency selected for that item. 

NOTE: In case of Zip file upload, your zip file should consist of 2 elements: spread sheet consisting of 

the line items and a folder consisting images for each line item mentioned in spread sheet. 

5. Click Upload File button to upload selected catalog file & proceed to the Map Columns sub step. 

 

 

 

6. Drag and Drop the Standard Catalog Columns to map the Columns of the uploaded catalog file 

with the fields in ZSN. 

7. Click Continue to conclude the Map Columns sub step and proceed to the Validate sub step. 

8. If the catalog is going to take a while to upload, then you will see the following message: 
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9. This message will notify that you have an option of letting the catalog upload in the background 

or you can stage on this same page until the catalog is uploaded. 

• To allow the upload in the background, click Yes 

• To wait for the catalog to upload, click No, I’d like to stay on this page 

10. The uploaded catalog file is processed and you will be able to view the items that have been 

successfully uploaded, have errors and warnings items. 
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11. Warnings are denoted by icon. 

12. Errors are denoted by icon. 

13. If you click Discard error items or Discard All Errors, then the Catalog wizard will permanently 

delete the line items containing errors. 

 

Fixing Errors via File 

 

14. Click Fix errors via file to correct multiple errors. Following popup will be displayed: 

 

 

15. Fixing errors via file is a two-step process: 

• Download the error file (this file will only contain the error line items that needs to be 

changed). Make the necessary changes. 

• Upload the corrected file. 

 

Fixing Errors on ZSN 

 

1. If the errors are less in number, you can fix the errors on the tool as shown below: 
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2. Hover on error icon to view the error. 

3. For example, if the item is not classified, you will have to manually classify the items. 

4. When the errors will be corrected, you will notice that error icon will disappear. 

 

5. Click Continue to conclude the Validate sub step and proceed to the Classify sub step. 
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6. Click Continue to conclude the Classify sub step and proceed to Step 4: Validate & Publish. 

 

 

 

 

 
Step 3: Item Details is not applicable in case of Offline Catalog File Upload. 
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Step 3: Item Details 

 

Refer to the  

Online Creation section for steps to be performed in Step 3. 

 

Step 4: Validate & Publish 

 

1. Using the  icon, select the time period for which the Catalog is valid. 

 

 

 

2. Check the Select to share this catalog with customers option to select customers with whom 

the Catalog is to be shared. 

 

 

3. Enter the Discount %, Description, and select the Validity of the Catalog for each Customer. 

 

 

 
Step 3: Item Details is not applicable in case of Offline Catalog File Upload. 

 

If no Customers are selected to share the Catalog with, the Catalog remains Private and is 
not visible to any Customers. 
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4. Click Submit to proceed and share the Catalog with the selected Customers. 

6.9.2 How to Edit a Catalog? 
 

As a supplier, you can edit a published, rejected, deactivated or expired catalog. 

To edit a Catalog: 
 

1. Navigate to the following location: Side Panel > My Catalogs > View Catalogs > Required 

Customer Company. 

 

2. Look for the required catalog using the Search, Filter or Sort options which has following status: 

• Published 

• Deactivated 

• Rejected 

• Expired 

3. For the required Catalog, click on the  icon corresponding to it. 

 

4. You will land on the following page:  
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Note: You can change the Buyer Email ID, if required from this page. 

5. Once you revisit the basic details for a catalog, you can go ahead with the next step of updating 

the line items.  

6. Make the required changes in the Catalog and Save the catalog by performing the step 

mentioned in Online Creation for Online Upload and Offline Creation for Offline Upload. 

1. How to Add/Upload New Items to the Catalog? 

 

You can edit or add new items to your existing catalogs to update the catalog with latest items. 

1. For a given catalog, from the Catalog listing page (Side Panel > My Catalogs > View Catalogs > 

Customer Name), go to Actions drop-down menu and click Edit. You will be navigated to 

following page. 

 
Published Catalogs cannot be edited unless deactivated first. 
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You can upload more items via file or you can add more items on the ZSN tool itself. 

To add more items via file: 

a. click Upload File as shown below: 

 

 

b. Click Select File to upload a file form your local system to upload. 
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Note: If you upload a same file twice, then ZSN tool will accept it as new items but will display the 

respective duplicity. 

 

c. When you upload the file, in case the parsing mapping is needed, the mapping page will also 

open in a pop up on the same page. 

d. Click Done when you finish mapping the columns.  

 

e. Once the user uploads the catalog and maps the columns, they will see a popup as shown 

below, where they will have the option to continue with other work while the catalog is 

uploading or stay on the page until the catalog is updated/uploaded. 

 

f. If the user selects Yes, they will be navigated to the catalog listing page where they would be 

able to upload/update other catalogs, else they can continue with any other work on ZSN and 

also choose to logout.  
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g. Once the catalog upload is complete, an email will be sent to the registered email address of 

the user who was uploading the catalog. 

 

To add Items on the ZSN tool: 

a. Click Add Item as shown below: 

 

b. Following popup will be displayed: 
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c. Enter the item details as requested. (*) marked are mandatory fields. 

NOTE: Ensure that the Supplier Part ID is unique. If the Supplier Part ID is already existing, then you 

will be notified with a popup as shown below: 

 

 

2. How to Update Multiple Line Items? 

 

1. For a given catalog, from the Catalog listing page (Side Panel > My Catalogs > View Catalogs > 

Customer Name), go to Actions drop-down menu and click Edit. You will be navigated to Catalog 

Parsing Summary section. 
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2. Select multiple line items by checking the box against each line item and click Update Selected. 

 

 

3. On selecting Update Selected, following popup will be displayed: 

 

 

4. You will be able to update the standard item details such as Product Category, Category Code, 

UOM, Currency, Product URL, Manufacturer Name, URL, Delivery Lead Time (days), Is green?, 

and De-activate Items? Information. 
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Note: If there are any items already added in the catalog, you will not be able to modify the 

taxonomy of the catalog. However, you can update all other details. 

He will not be able to update the Supplier Company and customer company for any of the catalogs. 

3. How to Update Line Items Individually? 

 

1. For a line item consisting errors, you can edit/update that line item on the ZSN tool itself. The 

items with error will be marked with icon. 

2. Hover on the icon to view the error. 

 

 

3. Add the missing information to update the line item. Click Continue to process the catalog 

forward. 

 

Note: If there are any items already added in the catalog, you will not be able to modify the 

taxonomy of the catalog. However, you can update all other details. 
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4. How to Delete all the Line Items in an Catalog? 

 

1. To delete all the items in an catalog, on the Catalog Parsing Summary page, click Delete All 

Items (highlighted). 

 

2. This will select and delete all the items on all the pages of the catalog. 

 

6.9.3 Cloning a Catalog 
 

Suppliers who have similar catalogs for more than one customer can reduce the time spent on creating 

new catalogs every time. Once a catalog is fully set up, it can be cloned to copy all relevant details. 

Supplier can then focus only on the data to be changed (for example: Item price, discount details, and 

so on) and submit the catalog. 

Note: All catalogs (except those in Draft state) can be cloned. 

Let’s take a look at this in action. To clone a contract: 

1. Go to the Catalog listing page from side panel > My Catalog > View/Update Catalogs > select 

buyer company. 
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2. One this listing page, click the Actions option to clone an existing catalog. You will see the option 

to clone that catalog as shown in the image below: 

 

3. Once you click to clone, you will need to select a buyer for whom you are cloning the catalog. 
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4. Choose a buyer form the drop-down list and click Clone. You will be redirected to the Catalog 

Details page: 

 

5. Fill in the mandatory details such as Catalog Name and your Supplier Company. Click Continue. 

6. The next step will be to add/update the items in your catalog as shown in the image below: 
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7. All the items from the original catalog will be replicated in the new catalog. You can choose to 

add, remove, or update the items from the catalog. For more help on adding items to the 

catalog, refer Upload Catalog. 

8. Once all the items are added, click Continue. The next step is to review and enter the validity for 

your catalog as shown below: 
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9. Once the required information is added, click Submit. You will be able to view your submitted 

catalog on the listing page as shown below: 
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6.9.4 Catalog Versioning 
 

1. When the user edits a catalog, a new version of that catalog is created.  

2. Version numbering is denoted as V1, V2, and so on. 

3. Catalog versioning is visible on the catalog listings page as shown below: 

 

 

NOTE: All the existing catalogs will be considered as Version 1. 

4. Once a supplier edits a Published catalog, a newer version will be created. The older version will 

also be available on the listing page. 

5. Once the latest version is published, then supplier will not be able to take any actions from the 

previous versions. 

  

https://www.surveymonkey.com/r/2C3X2XK


 
 

 
  

Zycus Inc: 103 Carnegie Centre, Suite 201, Princeton, NJ 08540, Tel: +1 866-563-9219, Fax: 609 799 6047 

Zycus Supplier Network User Guide – Yellow 

Click Here to Give Feedback 

6.9.5 How to Delete a Catalog? 
 

To delete a Catalog: 
 

1. Navigate to the following location: Side Panel > My Catalogs > View Catalogs > Required 

Customer Company 

 

2. Look for the required Draft or Deactivated catalog using the Search, Filter or Sort options 

 

3. For the required Draft or Deactivated Catalog, click on the  icon corresponding to it 

 

 

 

4. Click Yes to delete the catalog 

 

 

  

 
Published Catalogs cannot be deleted unless deactivated first. 

 

On deleting catalogs, the respective buyer company will be notified. Also the same catalog 
will be updated in eProc with status Deleted 
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6.9.6 Deactivating a Catalog 
 

1. You can choose to deactivate a catalog created for your company from ZSN. 

2. You will only be able to deactivate a Published catalog. 

3. To deactivate a catalog, go to the Catalogs listing page. 

4. Filter the catalogs with Published status. 

5. For a given catalog, click on the Actions drop-down menu and click Deactivate. 

 

6. A Confirmation popup will appear. Click Yes. 

 

7. Catalog will be successfully deactivated. 
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6.9.7 Catalog Audit Trail 
 

Audit trail offers a functionality to track the changes in the catalog created against the supplier 

company. 

To access audit trail, follow the given steps: 

1. From the side panel, go to My Catalogs.  
2. Hover over View Catalogs.  
3. Click on the customer company name for which you want to view the catalogs. 
 

 
 
4. The catalog listing page will be displayed as shown below.  
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5. Click on the Catalog name you wish to view. On clicking the catalog name, following page will be 
displayed: 
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NOTE: Audit Trail will only be visible in View mode, not in Edit Mode. This applies as Audit Trail will only 
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be visible for catalogs with following status: 

• Under Review 

• Ready For Approval 

• In Approval 

• Rejected 

• Deactivated 

• Published 

• Submitted 

• Scheduled 

• Expired 
 

6. Audit trail will be visible at the bottom of the page. Audit trail captures the following data: 
a) Actions: Actions performed on the catalog. Various actions that can be performed on the catalog 

are: 

• Submit - Catalog Submitted 

• Activate - Catalog Submitted once published in eproc then it will move to Catalog 
Published. 

• Deactivate - Catalog Deactivated 

• Edit & Submit - Catalog Updated 

• Ready for approval - Catalog Ready for approval 

• In Approval- Catalog In Approval 

• Under Review - Catalog Under review 

• Rejected - Catalog Rejected 

• Scheduled - Catalog Scheduled 

• Expired - Catalog Expired 
 

b)  User: The user name who performed any action on the catalog 
c) Version: This will display the version number based on the modifications made to a catalog. 
d) Date/Time: Displays the time and date when actions were be performed on the Catalog. 
e) Message: Displays comments added by the user in case any modifications made. 
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6.9.8 Catalog Upload Status 
 
While uploading catalogs that are created offline, processing may take a while if the file size is big. To 
ensure that the user does not have to wait for this process to complete, ZSN runs the upload process in 
the background. This will enable the users to access other pages of ZSN without any hindrance.  
 
If the user wants to check the status of their uploaded catalog, then they can view it from Catalog Upload 
Status page. 
 
1. To access this page, go to Side Panel > My Catalogs > Catalog Upload Status as shown below: 

 
 
2. You will land on the following page: 
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3. This page will display the following information: 

• Catalog Name 

• Customer Name 

• Supplier Company Name 

• Date on which the catalog was uploads 

• Upload Status 

• No. of Items uploaded from the catalog 

• Actions: 
▪ View the uploaded catalog  
▪ Clear the catalog names which have been successfully uploaded 

 
4. If you want to clear all the catalogs that are uploaded or failed, then click the highlighted button as 

shown below: 

 
 
Note: This page will auto-refresh in every five seconds which will give you a real time update on the 
progress of your catalog upload. 
 

6.9.8.2 Mail Updates on Catalog Uploads 

 

As a user, if you have uploaded a catalog on ZSN, then you will receive emails for change in the 

Catalog Status when: 

• The upload is successful 

• Or the upload has failed 
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6.9.9 Marking Filters as Favorites  
 

ZSN has enabled the option for the Suppliers to create a filter and save as a favorite. The user can 

also set one of the filters as their default view. By setting a default view, the listing page will display 

the entries based on the filters selected. 

 

To mark filter as favorite, 

1. Select the filter parameters from the left panel and click the Save as Favorite Filter button as 

shown in the image below: 

 

 

2. Once you choose to save a filter, you will have to name it as shown below: 

 

 

3. To set a filter as default, check the box as shown in the image above. Whenever the user will 

visit this page, the data will be filtered based on the selected parameters.  
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4. Saved filters will be available in the left panel of the listing page as shown below: 

 

 

5. You can have only one filter set as default. If you make another filter as default, then it will 

override the existing favorite filter and you will be notified as shown below: 

 

 

6. Click Yes if you wish to override the existing default filter. 

7. To remove a filter from favorite, go to the left panel and click Edit against a filter. 
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8. Uncheck the box against Save as Default and click Save. 

9. If you wish to delete a filter, click Delete in the popup shown above. 

6.10 From Where can I Access My Reference Documents? 

NOTE: The above-mentioned menu may or may not be available based on the access provided to you by 
customer. 

 

The My Reference Documents allows the user to view the reference documents for each customer 

even if the user is registered for the first time. 

 

6.10.1 View Customer Documents 
 

1. Click on My Reference Documents, you will get an option of View Customer Documents. 

2. Hover over View Customer Documents, you will get a list of customers for which you want to 

view the attached documents. 

  

3. You will be then able to view the reference documents related to customer. 
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6.10.2 View Reference Links 
 

4. Any links added by the buyer will be visible under View Reference Links. Select a buyer by 

clicking the drop-down menu. You will land on the following page: 
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